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6.1  XPS Introduction
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Analysis Position:
Analysis positions are defines as positions created on an Intro photo or SPS photo.  These positions will contain an associated analysis area [Point, Line, Area or HP]. 
Analysis positions also include positions defined at the time a SPS image is saved or SXI image is saved or when a Map file is loaded into the Position List Table.  These positions will be assigned single or multiple analysis areas using the Saved Image Viewer tools.
Acquisition Tasks will be accomplished by moving the stage to all Active analysis position(s) in the Position List Table characterized by a valid analysis area for the current acquisition.
Analysis Areas:
Analysis area(s) [Point, Line, Area or HP] are assigned to analysis positions created on an Intro photo or SPS photo at the time the analysis position was created. 
Single or multiple analysis areas are assigned to a SPS saved image or SXI saved image or to a saved Map image using the Saved Image Viewer tools.
Analysis areas will be used at each (analysis position) acquisition to define the X-Ray raster pattern used during analysis. 

In point analysis, a stationary X-Ray beam is positioned on a specific point.  In line or area analysis, the beam is rapidly scanned, or rastered, over an area of the surface.  In HP a horizontal raster pattern is generated to disperse the power across the Anode surface.

Scanned:
The Scanned mode operates the energy analyzer and detector in the traditional manner of scanning all data points across all detector channels. The scanned mode eliminates any detector signature and allows maximum flexibility for use of different pass energies, data point spacing, and energy range. 
UnScanned:
The UnScanned mode provides a higher speed (shorter data collection time) capability. In the UnScanned mode, the multi-channel detector captures a snapshot-like spectrum in a single event. The energy width of the spectrum is determined by the pass energy and the number of data points is 32. (The Quantera has a 32-channel detector.) 

Survey and Multiplex Spectrum: 

The purpose of collecting Survey spectra is to determine or confirm the elemental surface composition of the area being analyzed.  Collecting Multiplex spectra with narrow energy ranges allows you to optimize either spectral detail or sensitivity, while keeping the data collection time short.  [Scanned only]
Sputter Depth Profile: 

A sputter Depth Profile consists of a series of spectra that have been collected at different depths as material was removed from the sample.  The purpose of a depth profile is to verify or determine the construction of a thin film structure.  Applications include studying inter-diffusion of layers, looking for impurities in layers or at interfaces, and general characterization of surfaces and thin films.  [Scanned or UnScanned] 

Angle-Resolved Profile: 

Angle-Resolved (angle dependent) profiles are used to probe the near surface region of a sample in a non-destructive manner.  [Scanned or UnScanned]
Lines: 

Lines, typically, are used to provide detailed distribution information across an interface or a specific sample feature. [UnScanned only]
Maps: 

Maps provide a two-dimensional display of elemental or chemical state information.  Maps may provide information that directly leads to the solution of a problem.  More commonly, maps act as a guide, showing where additional spectra should be taken. [UnScanned only]

Acquisition Range/Window: 

The Energy Range of data collection defined in a Scanned acquisition by the Lower, Range and Upper parameters.

The Energy Range of data collection defined in a UnScanned acquisition by the Peak and Range parameters.

Analysis Range/Window: 

The Energy Range of data collection defined in a Scanned acquisition by the Analysis Lower and Analysis Upper parameters.

The Energy Range of data collection defined in a UnScanned acquisition by the Analysis Peak and Analysis Range parameters.

NOTE:  The Analysis window is used to define that range of the data that is used to calculate Peak Intensities related to Depth information or Spatial intensities.
NOTE:  It is important to make each window wide enough to include the entire XPS peak.  The windows need to be wide enough so that, if the sample charges and the XPS peak shifts upward in energy, the peak will not move outside the acquisition windows.
Refresh Acquire: 

Refresh is available to provide a real-time display of data for a single Region that will not be saved.  It is useful in setting up the acquisition and analysis ranges before acquisitions. [Scanned or UnScanned]

Queue: 

The Queue provides a mechanism to create a list of Queue Jobs and run all Jobs sequentially with a given Run Queue step.
Queue Acquisition Status Window: 

The Queue: Acquisition Status window provides sequential task information while a process is running.  The Remaining Time will be updated during an XPS acquisition.
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Tools to stop or abort a acquisition are always available within the Queue: Acquisition Status window.
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 Stop:
Stop Current Task button terminates data acquisition at the completion of the current Frame/Sweep/Cycle and saves the data file. Analysis will proceed on other analysis positions or other queues.
[image: image4.png]Stop



 Stop All: [button to the right of the Stop]
Stop All Tasks button terminates data acquisition at the completion of the current Frame/Sweep/Cycle and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.
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 Abort:
Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other analysis positions or other queues.
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 Abort All: [button to the right of the Abort]
Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.
6.2 How To:
6.2.1  Survey: Acquire Data
An XPS Survey is a quick, high-sensitivity acquisition of XPS data over a wide energy range.  An XPS Survey scan is used to identify which elements are present in the analysis area.  This is typically the first step in any sample analysis, providing an overview of elements present that will guide the design of the remaining analysis session.

An XPS Survey involves acquisition of one spectrum from a quick, high-sensitivity scan of a wide energy range (typically 1100 to 0 eV in 1 eV steps, at 20 milliseconds/point) to survey the elements present at a point or area on the sample.  The highest Pass Energy (280eV) is used to maximize elemental sensitivity and not chemical sensitivity (energy resolution).  

Another part of the analysis strategy for survey spectra is to use the largest diameter X-Ray probe that is possible, while confining the analysis to the feature of interest.  With the Quantera, X-Ray power increases linearly as the diameter of the X-Ray spot increases.  Time is also a variable in the survey experiment.  However, the quality of the spectrum increases as the square root of time, so it is very desirable to optimize the other parameters first. 
It is assumed that the sample is in the analysis chamber (Intro Session) and that analysis positions and analysis areas have been defined (Sample Session).

1. Select the desired Active analysis positions in the Sample > Position List Table.

2. Enable the Auto Z  Before Acquire (XPS > Properties > Setup) if the analysis positions have not been previously aligned

3. Enable the Automated Neutralization (XPS > Properties > Setup  or Status Bar) if the sample is insulating
4. Open the XPS Spectrum Application window.

5. Optional use of Spectrum Settings
a) Select a setting from the Spectrum Settings combo box.

b) Click the Load button.

6. Optional use of Previous Acquisition file Spectrum Settings
a) Click the File… box.
b) Choose a Spectrum file with desired settings.

c) Click Open.  The Spectrum Parameters will update with the acquisition file settings.

7. Select an X-Ray Setting picking the largest diameter X-Ray probe that is possible, while confining the analysis to the feature of interest.

8. Set the Pass Energy to 280

9. Add the Su1s Region to the Region List and set the Active boxes so only this Region is Active
10. Use the recommended 20ms Time Per Step (ms)
11. Select the number of Cycles to provide a data collection time of
1-3 minutes [Acquisition Tim (min)] for larger diameter X-Ray spots 
or 5-15 minutes [Acquisition Tim (min)] for smaller diameter X-Ray spots.
For example, an acquisition range of 1100 to 0eV, 1 sweep, 280PassEnergy, 1 eV/step and 20 ms/point, set for 13 Cycles, will result in a data collection of ~10 minutes [Acquisition Tim (min)].

12. Click the Start button in the Spectrum tab.

· The Queue: Acquire Spectrum box appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.

· One file will be saved with multiple traces [one for each analysis area]
· The Filename will be:
 <file prefix> . <platen name> . <position #> . <file number> . spe
· The  SmartSoft-XPS data will be displayed in the Spectral Viewer.  A Su1s Region will be displayed with a separate trace for multiple analysis areas.  

· All Active analysis positions in the Position List Table that are assigned a valid analysis area for the current acquisition will be visited sequentially.

· To Stop the acquisition before all Cycles are completed, use the Stop buttons or the Abort buttons in the Queue: Acquire Spectrum window.

· Stop Current Task button terminates data acquisition at the completion of the current Sweep and saves the data file. Analysis will proceed on other positions or other queues

· Stop All Tasks button terminates data acquisition at the completion of the current Sweep and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process. 

· Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other positions or other queues

· Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.

6.2.2 Survey: Acquire More
The sample platen must be at the same analysis position and no XPS parameters should have been changed.  Survey should be the last acquisition that was Stopped or completed.  Any Inactive Regions from the Survey acquisition will be removed from the Region List when the More acquisition is started.  Auto Neutralization and Beam Park will be supported.  Pre-sputter and Z-Align will not be repeated.
1. Click the More button in the Spectrum tab to add additional data to the Stopped or completed Survey.

2. Add more Cycles to increase the Analysis Time
Note: If the Survey was stopped; the current number of Cycles can be used to continue the Survey
3. Click the Start button

· The original acquisition file will be preserved with its previous name.
· One new file will be saved with multiple traces [one for each analysis area]
The new Filename will be:
<”previous name”> <+1> . spe
· Subsequent More acquisitions will preserve previous files; acquire new data and save a new file with the Filename:
<”previous name”> <+2> . spe
6.2.3 Survey: Data Reduction in SmartSoft-XPS 
Refer to the Multiplex subsection above for information on displaying data, smoothing data, identifying peaks, annotating peaks and copying/printing the depth profile using the toolbar buttons in the XPS output area.

6.2.4 Survey: Data Reduction in MultiPak
After collecting the survey spectra, open the MultiPak software to reduce the data.  The MultiPak Spectrum window and Periodic Table will appear.  For detailed information about the use of MultiPak, refer to the MultiPak Software Manual. 

1. Click the LastAcq button (which will open the file most recently acquired) or click the File button on the upper tool bar to open the file of choice from a File selection menu.

· The filename is displayed in green, indicating that this data is “selected.”  Any MultiPak functions activated will be performed on this data.
· The header (displayed only when Header in the View menu is checked) lists the file’s data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.).
· The third line of the header will be updated with a processing history as data reduction routines are applied to the data.
2. Click the PeakID button to identify and label the peaks in the spectrum.  This will:

· Perform an automatic charge correction based on the position of the C1s peak.

· Search its database to identify and label the peaks.

· Create a push button for each element in the Region bar at the bottom of the Spectrum window.  

3. Verify the accuracy of the labels using your experience and the Handbook of X-ray Photoelectron Spectroscopy, which is available from Physical Electronics.  If mistakes were made, you can correct them with one or more of the software tools available.  
· To remove a label, click on it and drag it outside the window using the left mouse button or turn OFF the element in the MultiPak Periodic Table by toggling it off with the left mouse button.  
· To label a peak or element that was missed by the Auto PeakID routine, you can turn that element ON in the Periodic Table by clicking the button for it.  This method will also create a pushbutton at the bottom of the Spectrum window for that new element. 

· If you do not know the identity of an unlabelled peak, you can manually search through the database of labels.  
a) Using the middle or right mouse button, click on an open area of the spectrum.  This will display a cursor and list ESCA transitions that occur at the current cursor location.  
b) While still holding down the mouse button, you can drag the cursor and search around the area of the unknown peak to see what elements occur in that energy range.  
Note: If you use the right mouse button for this operation, releasing the mouse button places the current label on the display at the location of the cursor.  
Note: If using the middle mouse button, when you release the mouse button, no labeling will take place.  
Note:  When labeling peaks in this manner, no buttons for the associated elements will be created at the bottom of the window.  If you want to add buttons for elements that were not identified by PeakID, you must create them by selecting the element from the Periodic Table.

4. Quantify Data in MultiPak.  Quantification of ESCA spectra is most accurate when Peak Area measurements are used.  In most situations, it is recommended that you use a Shirley Background Subtraction for making the area measurement.  
a) To view or change the end points that will be used to define the background subtraction for a specific elemental peak, click the button at the bottom of the Spectrum window for that element and the software will automatically expand the region for that element’s default peak and display the cursors that are used for background subtraction.  If it is necessary to adjust the cursors, click and drag the cursor using the left mouse button.  While the cursor is being moved, a line depicting the background will be displayed to assist you in positioning the cursor.  

Note: The default peak is defined in the Transition Editor menu and, usually, it is the main or major elemental peak.  If you want to change the default peak, you can do so in this menu. 

6.2.5  Multiplex: Acquire Data
A multiplex is a set of spectra from a series of high-resolution acquisitions of narrow energy ranges (typically 30 eV in 0.5 eV steps at 20 ms/point).  This type of acquisition yields great sensitivity and spectral detail in a short analysis time because only selected energy regions expected to contain XPS peaks of interest are scanned.  A multiplex acquisition is useful primarily when looking for trace elements.  As many as 20 elements can be acquired in one multiplex.

The more commonly used multiplex acquisition routines are the window Line scan and Depth Profile, which are described later in this section.  This subsection describes the basic Multiplex acquisition routine. 
A narrow energy range allows you to optimize either spectral detail or sensitivity, while keeping the data collection time short.  

To optimize spectral detail, a low Pass Energy is chosen (typically, 27 - 69eV) and the number of data points is increased (0.05 - 0.2eV/step).  There is a temptation to select a very low Pass Energy and a very small step size to obtain the “best” data.  In practice, it is necessary to make a compromise choice between the experiment time, Pass Energy, and data step size.  For an efficient, high-energy resolution experiment, you should use as high of a pass energy as possible, while still resolving the spectral features of interest.  You may also want to include the fewest number of data points possible while recording an accurate shape of the spectrum.  

To optimize elemental sensitivity, a high Pass Energy should be chosen (typically, 140 to 280eV) and the number of data points is reduced (0.2 to 0.4eV/step).  Since sensitivity increases almost linearly with Pass Energy, it is most advantageous to use as high of a Pass Energy as possible.

Use this customization capability to optimize an experiment. For example, if you would like high-resolution spectra of a few major elements, you can select a Pass Energy of 27eV for those elements.  For minor elements where the interest is sensitivity and quantification, you can select a Pass Energy of 224eV.  The MultiPak data reduction software is capable of reducing data files that have mixed Pass Energy and providing correct quantitative results.  
The required data acquisition time will depend on:

· The quantity of the element present in the analysis area 

· The Pass Energy 

· The X-Ray spot size. 

The data acquisition time may vary from a few minutes per element to 30 minutes per element.  The Analysis Time (min) displayed in the Spectrum menu is the total time for all elements selected.  

The following procedure assumes that the Multiplex acquisition is following an initial Survey acquisition, and that analysis areas or points have been defined.  Otherwise, verify that the sample is in the analysis chamber (Intro Session) and that analysis positions and analysis areas have been defined (Sample Session).

1. Select the desired Active analysis positions in the Sample > Position List Table.

2. Enable the Auto Z  Before Acquire (XPS > Properties > Setup) if the analysis positions have not been previously aligned

3. Enable the Automated Neutralization (XPS > Properties > Setup  or Status Bar) if the sample is insulating
4. Open the XPS Spectrum Application window.

5. Optional use of Spectrum Settings
a) Select a setting from the Spectrum Settings combo box.

b) Click the Load button.

6. Optional use of Previous Acquisition file Spectrum Settings
a) Click the File… box.

b) Choose a Spectrum file with desired settings.

c) Click Open.  The Spectrum Parameters will update with the acquisition file settings.

7. Select an X-Ray Setting picking the largest diameter X-Ray probe that is possible, while confining the analysis to the feature of interest.

8. Select a Pass Energy and Time Per Step (ms) combination that meets your needs.  (Refer to the Pass Energy discussion in the previous paragraphs.) 
Note: The Pass Energy [Default] in the Spectrum Parameters area will set the Pass Energy for all current and new Regions
Note: Unique Pass Energy settings can be applied for each Region using the Pass Energy in the Region Table area 

9. Select Regions for analysis.
Selecting Elements Using the Periodic Table 

Click the Period Table tool to select elements for analysis.  Click the button for each element to be analyzed in the Element Table.  This will define a narrow energy range for the most commonly used peak for each element
Selecting Elements Using the Import Elements Tool
Click the Import Elements tool to select elements for analysis.  This brings up the Import Element box.  Click the desired button to import elements used in previous Profile, Angle, Line or Map acquisitions. Selecting the Import Spectral Display will import elements identified in the “highlighted” Spectral Viewer [elements identified with Peak ID]
10. Select a number of Sweeps for each Region.  Define a higher number of Sweeps for elements that are present at lower concentrations to optimize the acquisition.
11. Customize the setup of each Region if desired.  Modify the energy range of an element or change the Pass Energy of a specific element.
Note: To see the entire table without using the scroll bar, click the Show Table Details icon in the table toolbar; this brings up the Multiplex Regions window.
Note: See the Region List Overview discussion for more details if needed.
12. Select the number of Cycles to provide a data collection time of
1-3 minutes [Acquisition Tim (min)] for larger diameter X-Ray spots 
or 5-15 minutes [Acquisition Tim (min)] for smaller diameter X-Ray spots.
13. Click the Start button in the Spectrum tab.

· The Queue: Acquire Spectrum box appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.

· One file will be saved with multiple traces [one for each analysis area]
· The Filename will be:
 <file prefix> . <platen name> . <position #> . <file number> . spe
· The  SmartSoft-XPS data will be displayed in the Spectral Viewer.  Each Region will be displayed within the viewer; with a separate trace for multiple analysis areas.
· All Active analysis positions in the Position List Table that are assigned a valid analysis area for the current acquisition will be visited sequentially.   

· To Stop the acquisition before all Cycles are completed, use the Stop buttons or the Abort buttons in the Queue: Acquire Spectrum window.

· Stop Current Task button terminates data acquisition at the completion of the current Sweep and saves the data file. Analysis will proceed on other positions or other queues

· Stop All Tasks button terminates data acquisition at the completion of the current Sweep and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process. 

· Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other positions or other queues

· Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.

6.2.6 Multiplex: Acquire More
The sample platen must be at the same analysis position and no XPS parameters should have been changed.  Multiplex should be the last acquisition that was Stopped or completed.  Any Inactive Regions from the Multiplex acquisition will be removed from the Region List when the More acquisition is started. Auto Neutralization and Beam Park will be supported.  Pre-sputter and Z-Align will not be repeated.
1. Click the More button in the Spectrum tab to add additional data to the Stopped or completed Multiplex acquisition.

2. Add more Cycles to increase the Analysis Time
Note: If the Multiplex acquisition was stopped; the current number of Cycles can be used to continue the acquisition
3. Click the Start button

· The original acquisition file will be preserved with its previous name.

· One new file will be saved with multiple traces [one for each analysis area]
The new Filename will be:
  <”previous name”> <+1> . spe
· Subsequent More acquisitions will preserve previous files; acquire new data and save a new file with the Filename:
<”previous name”> <+2> . spe
6.2.7 Multiplex: Data Reduction in SmartSoft-XPS 
Data reduction and reporting can be performed in SmartSoft-XPS or MultiPak.  MultiPak allows for more advanced data reduction.  In many cases the SmartSoft-XPS procedures will be sufficient.

Spectral Display

· Use the [image: image7.jpg]


 Zoom to enlarge a region of interest and the right-click Context menu; Fullscreen to revert back.

· Select the [image: image8.jpg]
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 Current Curve to view a single Region.

· Click the [image: image10.jpg]


 Fullscreen button for a full screen view of the Spectral Viewer.
· Note: With Profile or Line or Map data displayed; use the [image: image11.jpg]


 Fullscreen Data/Tile button to enlarge the highlighted file’s Spectral or Profile Viewer.

Annotate the Spectral Viewer

· Double-click within the viewer and type in text to annotate.  Click outside the text box to set the text.

· To move the text, click and drag the text to the desired location.

· To edit text, double-click over the text box, then edit.  Right-click over the text for more options (cut, copy, paste, delete, etc.).

· Right-click over the viewer for additional options, including delete all annotation.  Click the Properties option to open the Graph Annotation Properties box.  Use this box to select the text font, size, color, etc.
Data Reduction

· Use the 
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 9 Point Savitsky-Golay Smooth to smooth the data.

· Use the [image: image13.jpg]


 Peak Identification to identify peaks

· Use the [image: image14.jpg]


 Energy Cursor to identify peaks

· Use the [image: image15.jpg]


 Element Cursor to identify peaks

Output the Data
· Click the [image: image16.jpg]


  button to Copy the selected viewer to the clipboard.  This allows the data to be imported as a graphic into any Microsoft Office application (Word, PowerPoint, etc.).  

· Click the [image: image17.bmp] button to Print the selected viewer to the default printer.

NOTE:  Annotation changes made to the viewer are not saved as part of the data file.  

6.2.8 Multiplex: Data Reduction in MultiPak
After collecting the Multiplex data, open the MultiPak software to reduce the data.  The MultiPak Spectrum window and Periodic Table will appear.  For detailed information about the use of MultiPak, refer to the MultiPak Software Manual. 

1. Click the LastAcq button (which will open the file most recently acquired) or click the File button on the upper tool bar to open the file of choice from a File selection menu.
· Initially, all the individual spectra will be displayed on one energy axis, and there will be a button for each element at the bottom of the Spectrum window XE "Spectrum window" \i  (in the Region bar).
· To view the spectrum of an individual element, click the button that represents the element.
· The filename is displayed in green, indicating that this data is “selected.”  Any MultiPak functions activated will be performed on this data.
· The header (displayed only when Header in the View menu is checked) lists the file’s data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.).
· The third line of the header will be updated with a processing history as data reduction routines are applied to the data.
2. Quantify Data in MultiPak.  Quantification of ESCA spectra is most accurate when Peak Area measurements are used.  In most situations, it is recommended that you use a Shirley Background Subtraction for making the area measurement.  
a) To view or change the end points that will be used to define the background subtraction for a specific elemental peak, click the button at the bottom of the Spectrum window for that element and the software will automatically expand the region for that element’s default peak and display the cursors that are used for background subtraction.  If it is necessary to adjust the cursors, click and drag the cursor using the left mouse button.  While the cursor is being moved, a line depicting the background will be displayed to assist you in positioning the cursor.  

Note: The default peak is defined in the Transition Editor menu and usually it is the main or major elemental peak.  If you want to change the default peak, you can do so in this menu.
b) Click the % button to view the results of the atomic concentration calculation.
c) To print the AC Table, open the File pull-down list on the AC Summary window and click Print
3. Chemical Information in MultiPak.  If the focus of the spectrum is to examine the peak shape and position of the spectra to obtain chemical shift information, there are several software tools in MultiPak to help you with that task.  Before reducing the data in a spectrum, a smoothing routine may be applied to the data set to improve the accuracy of peak position and peak area measurements.  A Savitzky-Golay Smooth routine is recommended because it retains the original shape of the data curve during the smoothing process.  Depending on the size of the data steps in your data and the width of the peaks, a 5-, 7-, or 9-point smoothing operation is typically used.  To set up the preprogrammed Smooth button, which is displayed on the upper tool bar, click Data>Smooth/DerivativeSetup.  The Smooth/Derivative setup options will be displayed below the spectrum.  Using the left mouse button, select the Savitzky-Golay Smooth and the desired number of points to be used for smoothing.  If you selected nine points, the Smooth button in the upper tool bar will read “SG9.”  The smoothing functions operate on the displayed data.  If all of the data regions are displayed, all of the regions will be smoothed.  If you click the Smooth button a second time, the data will be smoothed twice.
4. Energy Scale Calibration in MultiPak.  The first step in extracting chemical information from a peak is to correct the energy scale for any shifts that are due to charging.  Typically, this is done by looking at the position of the C1s peak from the hydrocarbon that is present on the surface of most samples.  If the C1s peak is not at approximately 284.8eV, it should be adjusted using the Shift routine.  
a) To open the Shift routine, select Shift Setup from the Data pull-down list.
b) When a yellow cursor appears on the screen, position it with the left mouse button on the center of the hydrocarbon portion of the C1s peak.  
Note: When you release the mouse button, the C1s will shift to 284.8eV (or the position defined for C1s in your MultiPak Periodic Table database).  
Note: If no carbon is present on the sample, a peak from a matrix element with a known chemistry and binding energy may be used in place of the C1s to correct the energy scale for charge-induced shifts.
Note: The energy can be read by positioning the cursor on the peak and reading the value on the right side of the lower Spectral Shift tool bar.
5. Binding Energy Identification in MultiPak.  The next step in extracting chemical information is to determine the binding energy of the peaks for each element.  This can be done in several ways.  
a) With the peak displayed in the Spectrum window, position the cursor at the center of the peak, using the middle or right mouse button.  The location of the cursor is displayed in terms of the binding energy and intensity at the right side of the lower tool bar in the Spectrum window.  
b) The FWHM/Area Tool may also be used to determine the binding energy of a peak.  With the peak displayed in the Spectrum window, select the FWHM/Area function from the Tool pull-down list.  
The FWHM/Area Tool routine will automatically search for the most intense peak in the displayed data and display a list of information that describes the peak including its binding energy.  A yellow cursor is displayed where the software has determined the location of the peak to be.  If you want to change this position, grab the cursor using the left mouse button and drag it to the desired location.  When you have finished moving the cursor, the displayed information will be updated.
6. Curve Fit in MultiPak.  If the peak of interest contains more than one chemical state, it may be necessary to use the Curve Fit routine to determine the binding energy of each of the chemical states.  To perform a curve fit, use the following steps:
a) Make any necessary corrections to the energy scale using the Spectral Shift routine XE "Shift routine" \i .

b) Click the Curve Fit XE "Curve Fit" \i  button.

c) Deselect the Setup mode XE "Setup mode" \i  and adjust the energy cursors for background subtraction.
d) Select a Gaussian-Lorentzian peak shape.  (This peak shape is appropriate for most ESCA peaks.)
e) Define initial bands by pointing and clicking at the desired band position with the right mouse button.
f) Readjust the initial band estimates by entering numerical values in the Curve Fit Setup menu, or drag the flags attached to the currently selected band, using the left mouse button.  
g) Click Fit to start the fitting routine.
h) Evaluate the resulting peak positions as shapes using your experience, reference spectra, and database information.  
i) Make any necessary adjustments to the band parameters and click Fit again.
j) When you are satisfied with the results, print the Summary information and the curve fit spectrum.
k) Click Exit to leave the Curve Fit routine.
Note: The error (in red) follows the baseline evenly, indicating a good fit.
Note: The Curve Fit Summary table contains peak position information that can be used to determine the identity of the chemical state and peak area information to quantify those chemical states.  For a more detailed discussion of the Curve Fit software, refer to the MultiPak Software Manual.  
6.2.9  Depth Profile: Acquire Data
A sputter depth profile consists of a series of spectra that have been collected at different depths as material was removed from the sample.  An XPS depth profile is generally made by alternating sputtering with data acquisition.  The purpose of a depth profile is usually to verify or determine the construction of a thin film structure.  Other applications include studying inter-diffusion of layers, looking for impurities in layers or at interfaces, and general characterization of surfaces and thin films.  Before setting up for the depth profile, it is important to obtain as much information as possible about the thickness and composition of the layers to be monitored in the profile.  

The setup of the data acquisition parameters for a depth profile is similar to that used for narrow-range spectral acquisitions.  There are decisions to make with time, pass energy and step size.  You should consider whether you want to sputter the sample before collecting spectra.  The sputtering process may cause some chemical damage and broaden the peaks.  For this reason, depth profiles are usually collected with medium to high Pass Energies (112 - 224eV).  With these Pass Energies, there is sufficient energy resolution to observe most chemical shifts, and the higher Pass Energies improve sensitivity.  

Whether you are trying to optimize spectral detail or sensitivity, you should select as large an X-Ray spot size as possible, while restricting the analysis to the feature of interest.  This will provide the highest X-Ray flux possible to the analysis area and shorten the analysis time.

In addition to defining the data acquisition parameters for a sputter depth profile, you must also determine the sputter interval that is necessary to detect the layers you expect to see.  The parameters you can control for the sputter ion gun include:  

· accelerating voltage (beam voltage) 

· ion current 

· the size of the sputtered area, and 

· the option of rotating the sample while sputtering (Zalar( rotation).  

The sputter etching rate of the ion gun can be calibrated by measuring ion current with the Faraday cup and sputtering through a reference film of known thickness.  Reference films of SiO2 on Si and Ta2O5 on Ta are available from Physical Electronics and other suppliers of surface analysis accessories.

Before setting up a sputter depth profile, you must locate and define the intended areas of analysis.  

Note:  If you will be using the Zalar™ rotation during the profile, the analysis area must be within 25mm of the center of the platen.

The following procedure assumes that Survey or Multiplex acquisitions have been performed to identify Regions of interest and that analysis areas have been defined.  Otherwise, verify that the sample is in the analysis chamber (Intro Session) and that analysis positions and analysis areas have been defined (Sample Session).

1. Select the desired Active analysis positions in the Sample > Position List Table.

2. Enable the Auto Z  Before Acquire (XPS > Properties > Setup) if the analysis positions have not been previously aligned

3. Enable the Automated Neutralization (XPS > Properties > Setup  or Status Bar) if the sample is insulating
4. Open the XPS Profile Application window.

5. Optional use of Profile Settings
a) Select a setting from the Profile Settings combo box.

b) Click the Load button.

6. Optional use of Previous Acquisition file Profile Settings
a) Click the File… box.

b) Choose a Profile file with desired settings.

c) Click Open.  The Profile Parameters will update with the acquisition file settings.

7. Select an X-Ray Setting picking the largest diameter X-Ray probe that is possible, while confining the analysis to the feature of interest.

8. Select the desired UnScanned or Scanned Analyzer Mode.

9. Select a Pass Energy and Time Per Step (ms)/Time Per Region (ms) combination that meets your needs.  (Refer to the Pass Energy discussion in the Multiplex discussions.) 
Note: The Pass Energy [Default] in the Spectrum Parameters area will set the Pass Energy for all current and new Regions
Note: Unique Pass Energy settings can be applied for each Region using the Pass Energy in the Region Table area 

10. Select Regions for analysis.
Selecting Elements Using the Periodic Table 

Click the Period Table tool to select elements for analysis.  Click the button for each element to be analyzed in the Element Table.  This will define a narrow energy range for the most commonly used peak for each element
Selecting Elements Using the Import Elements Tool

Click the Import Elements tool to select elements for analysis.  This brings up the Import Element box.  Click the desired button to import elements used in previous Multiplex, Angle, Line or Map acquisitions. Selecting the Import Spectral Display will import elements identified in the “highlighted” Spectral Viewer [elements identified with Peak ID]
11. Select a number of Sweeps for each Region.  Define a higher number of Sweeps for elements that are present at lower concentrations to optimize the acquisition.
12. Customize the setup of each Region if desired.  Modify the energy range of an element or change the Pass Energy of a specific element.
Note: To see the entire table without using the scroll bar, click the Show Table Details icon in the table toolbar; this brings up the Profile Regions window.
Note: See the Region List Overview discussion for more details if needed.
13. Select the desired Sputter Mode [Alternate; Alternate w/Zalar; Alternate w/C60; Continuous or No Sputter].

14. Open the XPS >Properties > Profile window.

a) If Zalar is desired; Select Zalar Accuracy; Zalar Interval (cycle) and Rotation Speed (rpm)
b) Select desired PreSputter Cycles
c) Close the XPS >Properties > Profile window

15. Setup Sputter parameters and Cycles depending on the Sputter Mode
Note: the related Sputter Rate; Sputter Depth; # of Cycles; Total Cycles fields will be updated as parameters are entered.
Note: the Total Cycles will include the Pre-Sputter Cycles
	Alternate
	Continuous
	No Sputter

	Open the Sputter Rate Table window
	Select the desired Sputter Setting
	Select the # of Cycles

	Use the edit keys to create the desired number of sputter Layers and assign Names if desired
	Select the # of Cycles
	

	Select the desired Sputter Setting for each Layer
	
	

	Select the desired total Time (min) at each Sputter Layer
	
	

	Select the desired Interval (sputter time at each Cycle) The # of Cycles will be update to full-fill the Time (min) requested
	
	

	Close the Sputter Rate Table window
	
	


16. Click the Start button in the Profile tab.

· The Queue: Acquire Profile box appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.
· One file will be saved for each analysis area with multiple traces [a set of traces for each region (or energy)]
· Each file will contain Spectral Data and Depth Profile Intensity Data for each Region
· The Filename will be:
 <file prefix> . <platen name> . <position #> . <file number> _n. pro
with the _n indexed corresponding to each analysis area
(e.g. sample.101_1.pro and sample.101_2.pro) 
<file prefix> . <platen name> . <position #> . <file number> will remain the same for each analysis area file.
· The  SmartSoft-XPS Spectral data will be displayed in the Spectral Viewer.  Each Region will be displayed separately within the viewer.  There will be a Spectral Viewer for each analysis area.
· The Profile intensity plot will be displayed in the Profile Viewer. There will be a Profile Viewer for each analysis area.
· All Active analysis positions in the Position List Table that are assigned a valid analysis area for the current acquisition will be visited sequentially.

· To Stop the acquisition before all Cycles are completed, use the Stop buttons or the Abort buttons in the Queue: Acquire Profile window.

· Stop Current Task button terminates data acquisition at the completion of the current Sputter/Data Cycle and saves the data file. Analysis will proceed on other positions or other queues

· Stop All Tasks button terminates data acquisition at the completion of the current Sputter/Data Cycle and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process. 

· Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other positions or other queues

· Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.

6.2.10 Depth Profile: Acquire More
Flexible Profile is another means for extending a stopped or completed depth profile.  It allows any previous run profile to be extended (not just the last profile). There is also more flexibility in modifying the set of acquisition setup parameters.   Flexible Profile allows the user to stop a profile, perform other acquisitions, and then continue the profile.

· Acquired data is saved after each cycle for depth profile.   If the user aborts an acquisition and then resumes the aborted profile, the sputtering time that occurred in the aborted cycle may not be tracked.

· Users have the option to select a depth profile data file to extend.  The hardware values associated with the selected data file will be loaded.   Users could, but should not alter these setting values.

The following alterations are allowed:

· Modify or delete any Sputter Cycles that have not been completed

· Add new sputter Cycles
· Change the Delay Before Acquisition
· Change the Time/Step
· Change the Peak to Noise on/off

· Add new Regions
· Disable previously acquired Regions
· Change the Ratio and/or Sweep for a Region that already has data acquired

· Change the Peak/Noise value for a region that already has data acquired

· The Alternate Mode cannot be changed.

· Sputter layer settings (for layers that are completed) cannot be modified.

1. Click the More button in the Profile tab
If a Depth Profile had Stopped or completed; the file will be loaded in the Profile Settings and the acquisition parameters will be updated.

a) Continue below by modifying desired parameters

If the last Depth Profile had been aborted;

a) An Open File window will appear.

b) Select the aborted Profile file and click Open
Note: the filename for an aborted Profile will appear with the following format:
PlatenName.121 aborted at May 13 2008 14 7_1.pro
c) The Profile Acq Warning window will appear with a message

d) Follow the instructions to re-select the analysis position in the Sample > Position List Table and Drive the stage to this position if the stage has been moved

e) Continue below by modifying desired parameters

2. Modify desired parameters.

3. Click the Start button

The original acquisition file will be preserved with its previous name.

One new file will be saved with multiple traces [one for each analysis area]
The new Filename will be:
 <”previous name”> <+1> . pro

Subsequent More acquisitions will preserve previous files; acquire new data and save a new file with the Filename:
<”previous name”> <+2> . pro
6.2.11 Depth Profile: Data Reduction in SmartSoft-XPS 
Refer to the Multiplex subsection above for information on displaying data, smoothing data, identifying peaks, annotating peaks and copying/printing the depth profile using the toolbar buttons in the XPS output area.

6.2.12 Depth Profile: Data Reduction in MultiPak

After collecting the Profile data, open the MultiPak software to reduce the data.  The MultiPak Spectrum window and Periodic Table will appear.  Depth profiles are usually massaged and displayed in terms of atomic concentration versus sputter time.  For detailed information about the use of MultiPak, refer to the MultiPak Software Manual. 

1. Click the LastAcq button (which will open the file most recently acquired) or click the File button on the upper tool bar to open the file of choice from a File selection menu.

· Initially, all the individual spectra will be displayed on one energy axis, and there will be a button for each element at the bottom of the Spectrum window XE "Spectrum window" \i  (in the Region bar). The depth profile will be displayed in the Profile window.
· To view the spectrum of an individual element, click the button that represents the element.
· The filename is displayed in green, indicating that this data is “selected.”  Any MultiPak functions activated will be performed on this data.
· The header (displayed only when Header in the View menu is checked) lists the file’s data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.).
· The third line of the header will be updated with a processing history as data reduction routines are applied to the data.
2. With all spectra displayed in the Spectrum window (no individual region selected), click the Smooth button (SG5 - SG9) on the upper tool bar to smooth all the individual spectra from the profile.  Smoothing will improve the accuracy of the peak area measurements by reducing spectral noise and improving the placement of the endpoints used to define the background subtraction.  
3. Select each element individually by clicking the button for it on the Region Bar at the bottom of the Spectrum window, and adjust the analysis endpoints for background subtraction.
4. Click the % button in the Profile window to convert the relative intensity of the display to atomic concentration.  

The previous steps generate a quantitative elemental depth profile, which may often meet all your experimental needs.  MultiPak contains additional software tools, including an LLS Fit Routine that may be used to improve signal-to-noise, remove peak overlaps, and extract chemical state information from a depth profile.

Linear Least Square Fit (LLS Fit)

LLS (Linear Least Squares) fitting is a powerful tool that has the ability to improve detection limits, identify overlapping peaks and extract chemical state information.  It does this by examining the spectral shapes for an element at user selected regions of interest in the profile and applying extracted peak shapes to the data set using a Linear Least Squares Fit.  

To demonstrate LLS, this section will discuss profile data from a W/TiN/Ti/Si multilayer thin film structure.  The spectra were smoothed and the analysis endpoints were adjusted before displaying the peak area profile shown.  This data shows a significant amount of W in the Ti layer, and it is difficult to separate the TiN and Ti regions.  In an effort to determine if the W in the Ti region is “real” and to separate Ti from TiN, we will apply LLS.  

1. Click the LLS button on the upper tool bar and select W (Tungsten) by clicking on the W in the Region bar or the W data with the left mouse button.  
2. Select the regions of interest using the left mouse button.  
3. Click the Spec/New button to view the averaged spectrum from these regions.  
4. If the spectra are different and of interest, you can fit the data set with these extracted component spectra by clicking the Fit button.  
5. When finished with W, click the Display All button

6. Select Ti as the next element and adjust the regions, if necessary, using the left mouse button to move region boundaries.  If you want to turn off a region, double click on the region boundary with the left mouse button, which will change the region boundary appearance from a solid line to a dashed line.

7. When you are satisfied with the results, click the Display All button and exit LLS.  You will need to turn off the initial region buttons for the elemental data of W and Ti and any undesired regions, such as the W regions that are really Ti peak overlaps.  The result will be the removal of the Ti3p peak overlap with W4f and the separation of the Ti and TiN chemical states of Ti.  

For more details about the LLS routine, refer to the MultiPak Software Manual.  

The LLS routine is very effective at isolating chemical species or peak overlaps when relatively pure component spectra exist within a subregion of the depth profile.  If pure component spectra do not exist within the data set, curve fitting may be a good alternative for extracting chemical information from the profile.  The Curve Fit routine in MultiPak allows an entire region of a profile to be curve fit and the results to be brought into the profile for display and quantification.  For detailed information about curve fitting, see the MultiPak Software Manual.  

There are several options for outputting spectra from a depth profile.  You can use the buttons at the bottom of the Spectrum window to display all the spectra from a specific element. In addition, you can use the Select Spectra function to display a subset of all the spectra from a specific element.  You can use the Publish mode to display a montage plot of the spectra from an element or group of elements as shown.  Refer to the MultiPak Software Manual for additional information.

6.2.13  Angle Profile: Acquire Data
Angle-Resolved (angle-dependent) profiles are used to probe the near surface region of a sample in a non-destructive manner.  Angle Profiles are possible, because the input lens of the analyzer (SCA) can operate with a small acceptance angle, and it is possible to tilt the sample in front of the analyzer.  The analysis depth at a given angle is defined by the equation: 

d =  sin 

where d is the effective analysis depth, 
is inelastic mean free path (escape depth) and 
 is the angle between the sample surface and the analyzer input lens.  

Angle Profiles are used typically to measure the thickness or explore the chemistry of very thin layers.  Applications include the study of chemically modified surfaces, lubrication, cleaning processes, and such.

The setup of the data acquisition parameters for an Angle Profile is similar to that used for a sputter Depth Profile.  There are concessions to make with time, Pass Energy and step size. Angle Profiles are usually collected with low to medium Pass Energies (27 to140eV), because of the interest in obtaining chemical state information.  If elemental information is sufficient for a specific experiment, the Pass Energy could be increased to 240eV or higher.  

Whether you are trying to optimize spectral detail or sensitivity (count rate), you should select as large an X-Ray spot size as possible, while restricting the analysis to the feature of interest.  This will provide the highest X-Ray flux possible to the analysis area and shorten the analysis time.

For an Angle-Resolved acquisition, the sample should be mounted on the AR Platen.  The AR Platen has a raised center portion that allows it to be tilted from 5° to 90°.  When inserting an AR Platen into the Quantera, you must select the Angle Platen type in the Create Platen menu .  If you perform an AR acquisition on a Standard platen, the range of possible angles will be small and dependent upon the exact location on the platen.   

The following procedure assumes that Survey or Multiplex acquisitions have been performed to identify Regions of interest and that analysis areas have been defined.  Otherwise, verify that the sample is in the analysis chamber (Intro Session) and that analysis positions and analysis areas have been defined (Sample Session).

1. Select the desired Active analysis positions in the Sample > Position List Table.

2. Enable the Auto Z  Before Acquire (XPS > Properties > Setup) if the analysis positions have not been previously aligned

3. Enable the Automated Neutralization (XPS > Properties > Setup  or Status Bar) if the sample is insulating
4. Open the XPS Angle Application window.

5. Optional use of Angle Settings
a) Select a setting from the Angle Settings combo box.

b) Click the Load button.

6. Optional use of Previous Acquisition file Angle Settings
a) Click the File… box.

b) Choose a Angle file with desired settings.

c) Click Open.  The Angle Parameters will update with the acquisition file settings.

7. Select an X-Ray Setting picking the largest diameter X-Ray probe that is possible, while confining the analysis to the feature of interest.

8. Select the desired UnScanned or Scanned Analyzer Mode.

9. Select a Pass Energy and Time Per Step (ms)/Time Per Region (ms) combination that meets your needs.  (Refer to the Pass Energy discussion in the Multiplex discussions.) 
Note: The Pass Energy [Default] in the Spectrum Parameters area will set the Pass Energy for all current and new Regions
Note: Unique Pass Energy settings can be applied for each Region using the Pass Energy in the Region Table area 

10. Select Regions for analysis.
Selecting Elements Using the Periodic Table 

Click the Period Table tool to select elements for analysis.  Click the button for each element to be analyzed in the Element Table.  This will define a narrow energy range for the most commonly used peak for each element
Selecting Elements Using the Import Elements Tool

Click the Import Elements tool to select elements for analysis.  This brings up the Import Element box.  Click the desired button to import elements used in previous Multiplex, Profile, Line or Map acquisitions. Selecting the Import Spectral Display will import elements identified in the “highlighted” Spectral Viewer [elements identified with Peak ID]
11. Select a number of Sweeps for each Region.  Define a higher number of Sweeps for elements that are present at lower concentrations to optimize the acquisition.
12. Customize the setup of each Region if desired.  Modify the energy range of an element or change the Pass Energy of a specific element.
Note: To see the entire table without using the scroll bar, click the Show Table Details icon in the table toolbar; this brings up the Angle Regions window.
Note: See the Region List Overview discussion for more details if needed.
13. Select Standard or Narrow Acceptance Angle in the XPS > Properties > Profile window.

14. Select the XPS > Angle > Angle Table button to open the Angle Table window.

a) Use the edit keys to add the desired number of angles

b) Enter the desired Angle and Cycles for each angle
Note: The intensity response of the Quantera varies with the sine of the sample tilt angle.  For this reason, you should collect data for a longer time (more Cycles) at low angles.
c) Close the Angle Table window
Note: the Analysis Time; Runtime and Cycles will be calculated as a function of the Region parameters, Angle Table parameters and Angle Application tab parameters.
15. Click the Start button in the Angle tab.

· The Queue: Acquire Angle box appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.
· One file will be saved for each analysis area with multiple traces [a set of traces for each region (or energy)]
· Each file will contain Spectral Data and Angle Intensity Data for each Region
· The Filename will be:
 <file prefix> . <platen name> . <position #> . <file number> _n. ang
with the _n indexed corresponding to each analysis area
(e.g. sample.101_1.ang and sample.101_2.ang) 
<file prefix> . <platen name> . <position #> . <file number> will remain the same for each analysis area file

· The  SmartSoft-XPS Spectral data will be displayed in the Spectral Viewer.  Each Region will be displayed separately within the viewer.  There will be a Spectral Viewer for each analysis area.
· The Angle intensity plot will be displayed in the Profile Viewer. There will be a Profile Viewer for each analysis area.

· All Active analysis positions in the Position List Table that are assigned a valid analysis area for the current acquisition will be visited sequentially.

· To Stop the acquisition before all Cycles are completed, use the Stop buttons or the Abort buttons in the Queue: Acquire Profile window.

· Stop Current Task button terminates data acquisition at the completion of the current Cycle (for Scanned) and the current Angle (for UnScanned) and saves the data file. Analysis will proceed on other positions or other queues

· Stop All Tasks button terminates data acquisition at the completion of the current Cycle (for Scanned) and the current Angle (for UnScanned) and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process. 

· Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other positions or other queues

· Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.

More is not available for Angle acquisitions.

6.2.14 Angle Profile: Data Reduction in MultiPak

After collecting the Angle data, open the MultiPak software to reduce the data.  The MultiPak Spectrum window and Periodic Table will appear.  Angle profiles are usually massaged and displayed in terms of atomic concentration versus SIN .  For detailed information about the use of MultiPak, refer to the MultiPak Software Manual. 

1. Click the LastAcq button (which will open the file most recently acquired) or click the File button on the upper tool bar to open the file of choice from a File selection menu.

· Initially, all the individual spectra will be displayed on one energy axis, and there will be a button for each element at the bottom of the Spectrum window XE "Spectrum window" \i  (in the Region bar).
· To view the spectrum of an individual element, click the button that represents the element.
· The filename is displayed in green, indicating that this data is “selected.”  Any MultiPak functions activated will be performed on this data.
· The header (displayed only when Header in the View menu is checked) lists the file’s data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.).
· The third line of the header will be updated with a processing history as data reduction routines are applied to the data.
2. Click the Prof/Upd button on the spectrum window to view the Profile window.  The angle profile will be displayed in the Profile window.

3. With all spectra displayed in the Spectrum window (no individual region selected), click the Smooth button (SG5 - SG9) to smooth all the individual spectra from the profile.  Smoothing will improve the accuracy of the peak area measurements by reducing spectral noise and improving the placement of the endpoints used to define the background subtraction.
4. Select each element individually by clicking its button at the bottom of the Spectrum window and adjust the analysis endpoints for background subtraction.
5. Click the % button in the Profile window to display the relative intensity versus atomic concentration.  

The previous steps generate a quantitative, elemental angle-dependent depth profile.  MultiPak contains software tools that may be used to improve signal-to-noise, remove peak overlaps, and extract chemical state information from an angle profile.

One MultiPak tool that has the ability to improve the signal-to-noise ratio, remove peak overlaps and extract chemical state information is LLS (Linear Least Squares) fitting.  It does this by examining the spectral shapes for an element at user selected regions of interest in the profile and applying extracted peak shapes to the data set using a Linear Least Squares Fit.  The LLS software is applied to angle profiles in the same manner it is used for sputter Depth Profiles.  For a detailed discussion of LLS, refer to the Sputter Depth Profile section of this manual or the MultiPak Software Manual.   

The LLS routine is highly effective at isolating chemical species or peak overlaps when relatively pure component spectra exist within a subregion of the angle profile.  If pure component spectra do not exist within the data set, curve fitting may be a good alternative for extracting chemical information from the profile.  The Curve Fit routine in MultiPak allows an entire region of a profile to be curve fit and the results to be brought into the profile for display and quantification.  For detailed information about curve fitting, see the MultiPak Software Manual.
To output angle profiles, click the File button on the menu bar and then click Print on the pull-down list.  Once the Print Setup menu is correctly configured, it is only necessary to click the Print button located below the upper tool bar.
There are several options for outputting spectra from an angle profile.  Use the buttons at the bottom of the Spectrum window to display all the spectra from a specific element. In addition, you can use the Select Spectra function to display a subset of spectra from a specific element.  You can use the Publish mode to display a montage plot of the spectra from an element or group of elements.  Refer to the MultiPak Software Manual for additional information. 

6.2.15  Line: Acquire Data
Lines provide a two-dimensional display of elemental or chemical state information.  Typically, Lines are used in situations where it would be too time consuming either to collect a Map or to determine the detailed shape of an edge or interface.  

A Lineis a single row of pixels or data points.  A complete spectrum is collected at each pixel.  These spectra are collected in what is called an “UnScanned” mode.  That is, the entire spectrum is collected in one step, like a snapshot, which greatly reduces the time required to collect a line.  The UnScanned spectra contain 32 data points, one from each detector channel.  The width of the spectrum will be 11.1 percent of the pass energy being used to collect the data.  If a Pass Energy of 280eV is used, the energy width will be 31eV (1eV/channel).  

Lines are often collected with a Pass Energy of 280eV, because of the large number of data points and the need to collect data with a good signal-to-noise ratio in a short period of time.  Use a spot size that is similar in size to the features you expect to see in the line.  With the minimum X-Ray spot size of 10(m, a line for a major element will require an acquisition time of about five minutes and for a low concentration element 20 to 60 minutes, depending on its concentration and relative elemental sensitivity.  If a larger X-Ray spot size is used, the acquisition time will be shortened.  

Before setting up a line, you must locate and define the analysis area.  For imaging acquisitions, it is especially important to be at the focal point of the X-Ray and analyzer optics.  The Auto-Z function should be used to find the focal point before defining lines.  Lines may be drawn at any angle from horizontal to vertical.  

The following procedure assumes that Survey or Multiplex acquisitions have been performed to identify Regions of interest and that Line analysis areas have been defined.  Otherwise, verify that the sample is in the analysis chamber (Intro Session) and that analysis positions and Line analysis areas have been defined (Sample Session).

1. Select the desired Active analysis positions in the Sample > Position List Table.
Note: there must be at least one “line” analysis area selected
2. Enable the Auto Z  Before Acquire (XPS > Properties > Setup) if the analysis positions have not been previously aligned

3. Enable the Automated Neutralization (XPS > Properties > Setup  or Status Bar) if the sample is insulating
4. Open the XPS Line Application window.

5. Optional use of Line Settings
a) Select a setting from the Line Settings combo box.

b) Click the Load button.

6. Optional use of Previous Acquisition file Line Settings
a) Click the File… box.

b) Choose a Line file with desired settings.

c) Click Open.  The Line Parameters will update with the acquisition file settings.

7. Select an X-Ray Setting picking a spot size that is similar in size to the features you expect to see in the Line.

8. Set the Pass Energy to 280 eV

9. Select Regions for analysis.
Selecting Elements Using the Periodic Table 

Click the Period Table tool to select elements for analysis.  Click the button for each element to be analyzed in the Element Table.  This will define a narrow energy range for the most commonly used peak for each element
Selecting Elements Using the Import Elements Tool

Click the Import Elements tool to select elements for analysis.  This brings up the Import Element box.  Click the desired button to import elements used in previous Multiplex, Profile, Angle, or Map acquisitions. Selecting the Import Spectral Display will import elements identified in the “highlighted” Spectral Viewer [elements identified with Peak ID]
10. Select a number of Sweeps for each Region.  Define a higher number of Sweeps for elements that are present at lower concentrations to optimize the acquisition.
11. Customize the setup of each Region if desired.  Modify the energy range of an element or change the Pass Energy of a specific element.
Note: Unique Pass Energy settings can be applied for each Region using the Pass Energy in the Region Table area 
Note: To see the entire table without using the scroll bar, click the Show Table Details icon in the table toolbar; this brings up the Line Regions window.
Note: See the Region List Overview discussion for more details if needed.
12. Select the number of Cycles.
13. Click the Start button in the Angle tab.

· The Queue: Acquire Line box appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.
· One file will be saved for each analysis area with multiple traces [a set of traces for each region (or energy)]
· Each file will contain Spectral Data, Line Intensity Data and a memory map file for each Region
· The Filename will be:
 <file prefix> . <platen name> . <position #> . <file number> _n. lin
with the _n indexed corresponding to each analysis area
(e.g. sample.101_1.lin and sample.101_2.lin)
<file prefix> . <platen name> . <position #> . <file number> will remain the same for each analysis area file
· The  SmartSoft-XPS Spectral data will be displayed in the Spectral Viewer.  Each Region will be displayed separately within the viewer.  There will be a Spectral Viewer for each analysis area.
· The Line intensity plot will be displayed in the Profile Viewer. There will be a Profile Viewer for each analysis area.

· All Active Line analysis positions in the Position List Table will be visited sequentially.

· To Stop the acquisition before all Cycles are completed, use the Stop buttons or the Abort buttons in the Queue: Acquire Line window.

· Stop Current Task button terminates data acquisition at the completion of the current Sweep and saves the data file. Analysis will proceed on other positions or other queues

· Stop All Tasks button terminates data acquisition at the completion of the current Sweep and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process. 

· Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other positions or other queues

· Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.

6.2.16 Line: Acquire More
The sample platen must be at the same analysis position and no XPS parameters should have been changed.  Line should be the last acquisition that was Stopped or completed.  Any Inactive Regions from the Line acquisition will be removed from the Region List when the More acquisition is started.  Auto Neutralization and Beam Park will be supported.  Pre-sputter and Z-Align will not be repeated.
1. Click the More button in the Line tab to add additional data to the Stopped or completed Line acquisition.

2. Add more Cycles to increase the Analysis Time
Note: If the Line acquisition was stopped; the current number of Cycles can be used to continue the acquisition
3. Click the Start button

The original acquisition file will be preserved with its previous name.

One new file will be saved 
The new Filename will be:
  <”previous name”> <+1> . lin

Subsequent More acquisitions will preserve previous files; acquire new data and save a new file with the Filename:
<”previous name”> <+2> . lin
6.2.17 Line: Data Reduction in SmartSoft-XPS 
Refer to the Multiplex subsection above for information on displaying data, smoothing and differentiating data, annotating peaks and copying/printing the Line scan using the toolbar buttons in the XPS output area.
6.2.18 Line: Data Reduction in MultiPak 
After collecting the Line data, open the MultiPak software to reduce the data.  The MultiPak Spectrum window and Periodic Table will appear.  For detailed information about the use of MultiPak, refer to the MultiPak Software Manual. 

1. Click the LastAcq button (which will open the file most recently acquired) or click the File button on the upper tool bar to open the file of choice from a File selection menu.

· Initially, all the individual spectra will be displayed on one energy axis, and there will be a button for each element at the bottom of the Spectrum window XE "Spectrum window" \i  (in the Region bar).
· To view the spectrum of an individual element, click the button that represents the element.
· The filename is displayed in green, indicating that this data is “selected.”  Any MultiPak functions activated will be performed on this data.
· The header (displayed only when Header in the View menu is checked) lists the file’s data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.).
· The third line of the header will be updated with a processing history as data reduction routines are applied to the data.
The unprocessed Line will be displayed in the Profile window, and all the spectra from the Line will be displayed in the Spectrum window.

When all the spectra have been loaded, a background correction will be made, based upon the location of the analysis cursors.  The line display will be updated with the newly calculated peak measurement information.

The first step in data reduction of a Line is to adjust the analysis cursors in the Spectrum window for each region for a proper background subtraction.  Each time you make an adjustment with the analysis cursors, the line will be redrawn using the newly calculated peak area values.  

Line data may be reduced and displayed in the same manner as a depth profile.  It is possible to smooth, quantify, curve fit or use LLS fitting on line data.  For details of these operations, refer to the Sputter Depth Profile section of this manual or the MultiPak Software Manual.

6.2.19  Map: Acquire Data
Maps provide a two-dimensional display of elemental or chemical state information.  Maps may provide information that directly leads to the solution of a problem. More often, maps act as a guide, showing where additional spectra should be taken.   
Because low concentrations of highly localized elements can be easily overlooked, complete surface characterization requires careful observation.  Acquiring XPS elemental maps, then superimposing them upon each other reveals any unidentified areas on the surface.  Point spectra acquired from these areas quickly identify one or more new elements, which are then mapped and added to the overlay.  This overlay of XPS maps provides a picture of the two-dimensional distribution of surface elements.  Superimposing maps upon each other also can reveal any unidentified areas on the surface. 
Maps consist of an array of individual pixels.  With the Quantera, a complete spectrum is collected at each pixel.  These spectra are collected in what is called an “UnScanned” mode.  That is, the entire spectrum is collected in one step, like a snapshot, which greatly reduces the time required to collect a Map.  The UnScanned spectra contain 32 data points, one from each detector channel.  The width of the spectrum will be 11.1 percent of the Pass Energy being used to collect the data.  If a Pass Energy of 280eV is used, the energy width will be 31eV (1eV/channel).  

Maps should be collected using the maximum Pass Energy of 280eV, because of the large number of data points and the need to collect data with a good signal-to-noise ratio in a short period of time.  The X-Ray spot size should be as large as possible.  Use a spot size that matches the average-sized feature that you expect to see in the Map.  With the minimum X-Ray spot size of 10(m, a Mapfor a major element will require an acquisition time of 5 to10 minutes and for a low concentration element 20 to 60 minutes, depending on its concentration and relative elemental sensitivity.  If a larger X-Ray spot size is used, the acquisition times will be shortened.  

Before setting up a Map, you must locate and define the analysis area.  For imaging acquisitions, it is especially important to be at the focal point of the X-Ray and analyzer optics.  The Auto-Z function should be used to find the focal point prior to defining areas to be imaged.    

The following procedure assumes that Survey or Multiplex acquisitions have been performed to identify Regions of interest and that Map analysis areas have been defined.  Otherwise, verify that the sample is in the analysis chamber (Intro Session) and that analysis positions and Map analysis areas have been defined (Sample Session).

1. Select the desired Active analysis positions in the Sample > Position List Table.
Note: there must be at least one “area” analysis area selected
2. Enable the Auto Z  Before Acquire (XPS > Properties > Setup) if the analysis positions have not been previously aligned

3. Enable the Automated Neutralization (XPS > Properties > Setup  or Status Bar) if the sample is insulating
4. Open the XPS Map Application window.

5. Optional use of Map Settings
a) Select a setting from the Map Settings combo box.

b) Click the Load button.

6. Optional use of Previous Acquisition file Map Settings
a) Click the File… box.

b) Choose a Map file with desired settings.

c) Click Open.  The Map Parameters will update with the acquisition file settings.

7. Select an X-Ray Setting picking a spot size that is similar in size to the features you expect to see in the Map.

8. Set the Pass Energy to 280 eV

9. Select Regions for analysis.
Selecting Elements Using the Periodic Table 

Click the Period Table tool to select elements for analysis.  Click the button for each element to be analyzed in the Element Table.  This will define a narrow energy range for the most commonly used peak for each element
Selecting Elements Using the Import Elements Tool

Click the Import Elements tool to select elements for analysis.  This brings up the Import Element box.  Click the desired button to import elements used in previous Multiplex, Profile, Angle or Line acquisitions. Selecting the Import Spectral Display will import elements identified in the “highlighted” Spectral Viewer [elements identified with Peak ID]
10. Select a number of Sweeps for each Region.  Define a higher number of Sweeps for elements that are present at lower concentrations to optimize the acquisition.
11. Customize the setup of each Region if desired.  Modify the energy range of an element or change the Pass Energy of a specific element.
Note: Unique Pass Energy settings can be applied for each Region using the Pass Energy in the Region Table area 
Note: To see the entire table without using the scroll bar, click the Show Table Details icon in the table toolbar; this brings up the Map Regions window.
Note: See the Region List Overview discussion for more details if needed.
12. Select a value for the Sweeps Multiplier to define the Analysis Time.
13. Click the Start button in the Map tab.

· The Queue: Acquire Map box appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.
· Each Region will be acquired sequentially.
· The Map acquisition begins.  The incident X-Ray beam steps point by point along a line while peak intensity is measured at each point.  The beam repeats the motion on the same line to measure background intensity, at each point subtracting the background intensity from the peak intensity and saving only the value of the difference.  
· This is then repeated for the next line, and so on until all the lines have been acquired.  This is one “frame.”  This is then repeated for the next frame, at each point calculating and saving only the average of [peak-minus-background intensity at this point on this sweep] and [the value stored at this point during the preceding sweep].  When the specified number of frames/sweeps is completed, the acquisition for the next region (element) begins. 
· One file will be saved for each analysis area with multiple traces [a set of traces for each region (or energy)]
· Each file will contain Spectral Data, Map Intensity Data and a memory map file for each Region
· The Filename will be:
 <file prefix> . <platen name> . <position #> . <file number> _n. map
with the _n indexed corresponding to each analysis area
(e.g. sample.101_1.map and sample.101_2.map)
<file prefix> . <platen name> . <position #> . <file number> will remain the same for each analysis area file
· The  SmartSoft-XPS Spectral data will be displayed in the Spectral Viewer.  Each Region will be displayed separately within the viewer.  There will be a Spectral Viewer for each analysis area.
· The Map intensity plot will be displayed in the Image Viewer. There will be an Image Viewer for each Region of each analysis area.

· All Active Area analysis positions in the Position List Table will be visited sequentially.

To Stop the acquisition before all Maps are completed, use the Stop buttons or the Abort buttons in the Queue: Acquire Map window.

· Stop Current Task button terminates data acquisition at the completion of the current Frame and saves the data file. Analysis will proceed on other positions or other queues

· Stop All Tasks button terminates data acquisition at the completion of the current Frame and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process. 

· Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other positions or other queues

· Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.

6.2.20 Map: Acquire More
The Map acquisition must have been stopped during the first Region of the first analysis area.

The sample platen must be at the same analysis position and no XPS parameters should have been changed.  Map should be the last acquisition that was acquired.  Any Inactive Regions from the Map acquisition will be removed from the Region List when the More acquisition is started.  Auto Neutralization and Beam Park will be supported.  Pre-sputter and Z-Align will not be repeated.
1. Click the More button in the Map tab to add additional data to the Stopped or completed Map acquisition.

2. Increase the Sweeps Multiplier to increase the Analysis Time
Note: If the Map acquisition was stopped during the first Region of the first analysis area; the new Sweeps Multiplier will be used to continue the acquisition.  This will result in the first Region completing with the new number of sweeps and the remaining Regions performed with the new number of sweeps
Otherwise:
If the Map acquisition was stopped during the first Region of the first analysis area; the current Sweeps Multiplier will be used to continue the acquisition.  This will result in the first Region completing and the remaining Regions performed.
3. Click the Start button

· The original acquisition file will be preserved with its previous name.

· One new file will be saved 

· The new Filename will be:
  <”previous name”> <+1> . map
· Subsequent More acquisitions will preserve previous files; acquire new data and save a new file with the Filename:
<”previous name”> <+2> . map
6.2.21 Map: Data Reduction in SmartSoft-XPS   

Map Display

Click the [image: image18.jpg]


 button for a full screen view of the Image Viewer.

The maps acquired for all elements will be displayed.  To view only one Map, click the file name displayed above the desired Map to make it the selected map.  The file name will turn green.  Then, to display only that Map, click the [image: image19.jpg]


 button.

Alternatively, use the Current Image box  [image: image20.jpg]&



, to select a Map, and then use the [image: image21.jpg]


 button.
Annotate the Maps

Double-click over a Map and type in text to annotate.  Click outside the text box to set the text.

To move the text, click and drag the text to the desired location.

To edit text, double-click over the text box, then edit.  Right-click over the text for more options (cut, copy, paste, delete, etc.).

Right-click over the Map for additional options, including delete all annotation.  Click the Properties option to open the Image Annotation box.  Use this box to select the text font, size, color, etc.
Add Color to Maps

Color can be added to Maps as a first step in creating a color overlay, or to distinguish maps from each other in reports.  In addition, adding color to Maps can enhance analysis of the data in the maps.  

Select a Mapas indicated above, and then use the Color Map box  [image: image22.jpg]Fed




, to add color to the Map.  Options are red, green, blue, thermal and gray.  

The thermal option assigns red to dark pixels, and yellow to light pixels, using a gradient that includes red on the dark end, through orange, to yellow.  This option can better highlight information in some Maps.

Red, blue and green are selected as a first step toward creating a color overlay.

Create a Color Overlay

Overlays are used to determine whether there are areas of the sample that might require further analysis.  For example, areas showing little or no color might contain previously unidentified elements.  Overlays can also be used to better understand which elements are present in certain areas, such as an area of contamination.   

Select the three Maps to be used to create the overlay, and then assign the colors red, blue and green to those maps as indicated above.

NOTE:  A maximum of three Maps can be used to create an overlay.
Click the [image: image23.jpg]


 Overlay button to create the overlay.

Examine the overlay for areas that show little or no color.  Acquire Surveys of these areas, since they may contain previously unidentified elements. 

Output the Maps

Click the [image: image24.jpg]


  button to Copy the selected map to the clipboard.  This allows the map to be imported as a graphic into any Microsoft Office application (Word, PowerPoint, etc.).  

Click the [image: image25.bmp] button to Print the selected map to the default printer.

NOTE:  Changes made to the Map (annotation, adding color) are not saved as part of the data file.  

6.2.22 Map: Data Reduction in MultiPak  

After collecting the Line data, open the MultiPak software to reduce the data.  The MultiPak Spectrum window and Periodic Table will appear.  For detailed information about the use of MultiPak, refer to the MultiPak Software Manual. 

1. Click the LastAcq button (which will open the file most recently acquired) or click the File button on the upper tool bar to open the file of choice from a File selection menu.

· Initially, all the individual spectra will be displayed on one energy axis, and there will be a button for each element at the bottom of the Spectrum window (in the Region bar).
· To view the spectrum of an individual element, click the button that represents the element.
· The filename is displayed in green, indicating that this data is “selected.”  Any MultiPak functions activated will be performed on this data.
· The header (displayed only when Header in the View menu is checked) lists the file’s data acquisition parameters (date of acquisition, beam voltage of acquisition, etc.).
· The third line of the header will be updated with a processing history as data reduction routines are applied to the data.
The unprocessed Map will be displayed in the Map window, and all the spectra from the Map will be displayed in the Spectrum window.

Due to the large number of spectra that are stored in a map file, it may take a few moments to load the file, especially if the file contains maps for multiple elements.  When all the spectra have been loaded, a background correction will be made, based upon the location of the analysis cursors.  The Map display will be updated with the newly calculated peak measurement information.

The first step in the data reduction of a Map is to adjust the analysis cursors in the Spectrum window for a proper background subtraction.  Each time you make an adjustment with the analysis cursors, the Map will be redrawn using the newly calculated peak measurement values, if the DataLink is on.  If the DataLink is off, click the Imag/Upd button to update the image after making your changes.

Brightness Control and Contrast Stretching

The next step is to adjust the Brightness and Contrast using the software handles on the color bar to the right of the map.  Brightness is adjusted with the left handle and contrast is adjusted using the two handles on the right side of the color bar.  The left mouse button is used to click and drag the handles.  

After a Contrast adjustment, the Contrast Handle will be displayed in an unfilled or outlined mode.  When you finish adjusting the Contrast, you have to close (resolve) the contrast operation by clicking on the handle with the right mouse button.  The Contrast Handle will be displayed filled in.  

Performing a Contrast Stretch will improve the appearance of most maps.  For monotone displays (shades of green, blue, red or white), drag the lower contrast handle up to eliminate noise pixels in black areas, then drag the upper contrast handle down until the features of interest begin to saturate as indicated by their bright color during the contrast adjustment.  

From the Color Display pull-down menu on the lower tool bar (gray button), you can select: 

· a gray scale display mode 

· a color display using a combination of black with red, green, or blue, or

· one of two color contour modes that associate a color scheme with the peak intensities being displayed.  

Additional data massage tools are available for improving the signal-to-noise ratio of a Map and for extracting chemical information from ESCA maps.  To improve signal-to-noise, there are several mathematical filters available in the MultiPak software.  The most commonly used filter is a 3x3 Point Map Smooth (Smo3x3).  A 3x3 Smooth followed by a Contrast Stretch will enhance the appearance of many maps.  For detailed information about the filter routines, refer to the MultiPak Software Manual.

Center of Gravity (COG)

To extract chemical information from a Map, you have to make an educated guess about where the areas containing different chemistry are.  A tool called COG (center-of-gravity) is available to help you find areas with different binding energies on a Map.  To use the COG tool:  

· Select the spectrum for the desired element using the element buttons in the Region bar of the Spectrum/Map window.

· With the middle mouse button, click on one of the analysis cursors to open the Analysis Region Properties submenu.  

· Open the Intensity Type pull-down menu and select COG. 

· Click Apply or OK with the left mouse button.  

The COG routine will look at the spectrum associated with each pixel of the map and determine the binding energy centroid of the most intense peak of the spectrum.  

· Click the Imag/Upd button in the Spectrum window to update the map display.

The Map will be displayed with low binding energy pixels as black and high binding energy pixels as being white or bright.   

If there are areas of significantly different binding energy present in the map, they will appear in the COG display of the map.  The LLS (Linear Least Squares) fitting routine may then be used to extract reference spectra and apply a LLS fit to the Map data.  

Linear Least Squares (LLS Fitting)

To apply the LLS routine:

1. Select LLS from the tool bar in the Map window.

2. Use the left mouse button (click and drag) to select the rectangular areas of interest.

Image

1. Click the Spec/New button in the lower tool bar of the Map/Spectrum window to view the composite spectra created by adding the pixels contained within each selected area.

2. If the composite spectra appear to be useable as reference or component spectra for an LLS fit, click the Fit button and view the results in the Map window.  If necessary, redraw the areas and re-examine the composite fit, using Spec/New.

3. If the results are acceptable, exit the LLS routine.  The newly generated chemical maps will be displayed in the Map window.  

4. Smooth and contrast stretch the new maps as necessary.

Maps may be printed individually or in groups by clicking the Tile option at the top of the Map window.  

6.2.23 Perform Test Acquire
Perform a Test Acquire for each selected element.  Test Acquire provides an opportunity to determine whether the Acquisition Window Setup for each element is optimized.
It is important to make each window wide enough to include the entire XPS peak.  Since Test Acquires can be performed only for the elements on the surface, the operator needs to consider the windows of the buried elements, especially on samples where there may be charging layers below the surface.  The windows need to be wide enough so that, if the sample charges and the XPS peaks shift upward in energy, the peaks will not move outside the acquisition windows.
1. Select the desired XPS Application tab.
2. Left-click to select an Element to examine (highlighting the Element “green”)

3. Click the [image: image26.png]


 Refresh icon to launch the Test Acquisition
· The Refresh Acquire window will open.

· Refresh will provide a real-time display of data for a single Region that will not be saved.  

· The highlighted Region in the Region Table will be acquired in either a “Scanned” or “UnScanned” collection mode depending on the Analyzer Mode selected in the current application tab
· The Sweeps and Ratio will default to a temporary value=1

· The “Scanned” Time Per Step (ms) will default to a temporary value=10ms
The “UnScanned” Time Per Region (s) will default to a temporary value=1000ms
· The Persistence can be used to integrate more counts to improve the signal-noise
The Refresh acquisition will continue until the [image: image27.jpg]


 Stop button or the Acquisition Status Stop button is clicked.
4. Ensure that the full peak is contained within the analysis window.  Adjust the width or energy of the window to ensure that the peak remains within the window.
· Adjusting any of the following parameters will stop and restart a new Refresh acquisition:

Scanned

Lower; Range; Upper; Analysis Lower; Analysis Upper:

The Lower, Range and Upper parameters define the acquisition parameters for data collection for each Region.  
The Analysis Lower and Analysis Upper parameters define the analysis window that will be used in calculating the intensity data for each Region.

UnScanned 

Peak; Range; Analysis Peak; Analysis Range:

The Peak and Range parameters define the acquisition parameters for data collection for each Region.  
The Analysis Peak and Analysis Range parameters define the analysis window that will be used in calculating the intensity data for each Region.

Pass Energy [Pass]: 
The Pass Energy will define the analyzer band pass and resultant alignment of energies across the 32 channels.

eV Step:
The eV Step will define the energy resolution of the data file for each Region.  

· Selecting a new Element in the Region List will stop and restart a new Refresh acquisition

· Changing the Beam Offset X or Y will take affect with the next Refresh acquisition
Note: These fields define the position (um) of the X-Ray beam with respect to the center of the analysis area during a Refresh acquisition.
· Select the Large Counts Display icon to reveal larger font size to the Max Counts readings.

6.2.24 Queue Acquisitions
The Queue is available to generate a list of Jobs and to perform them sequentially as a single task.  These Jobs are added to the Queue from each of the five XPS Application tabs and Run from the Queue window.  It is required to have all of the analysis positions defined in the Sample > Position List Table and Add each Job to the Queue.  It is important not to run any acquisitions (XPS; SXI or Platen Transfers) while building the Queue as these tasks will over-write the Queue.  If intermediate operations are required while building the Queue it will be necessary to Save the Queue and re-Load the Queue to add more Jobs or to Run the Queue.
Refer to each XPS Application instructions regarding acquisition setup.  Refer to the Acquire & Queue Overview (All XPS Applications) for further information regarding Queue features.
1. Right-click on the Add Q button on any XPS Application tab and select Clear Queue to begin.
a) Select the “Current” platen to be used for analysis using the Intro > Chamber View.
Note: Left-click the border of the desired platen.
Note: the platen does not need to be on the Stage station; but needs to be within the analysis system [Stage, ParkA, ParkB, Auxiliary or Intro station]

b) Set the desired analysis positions to Active in the Sample > Position List Table.
c) Setup the desired XPS > Acquisition Properties for pre-acquisition and post-acquisition parameters.
d) Setup the desired XPS Application parameters 
e) Click the Add Q button
2. Repeat steps a - e to add additional Jobs to the Queue
3. Click the Open Queue… button on any XPS Application tab
This will open the Queue window for viewing
4. Click the [image: image28.png]


 Run button
· The Queue: Acquisition Status window appears displaying progress of the acquisition and displaying the Remaining Time in the acquisition.
· Refer to each XPS Application instruction regarding viewer updates and file saving operations.
· All Summary listed Active analysis positions in the Position List Table will be visited sequentially.

To Stop the acquisition before an acquisition is completed, use the Stop buttons or the Abort buttons in the Queue: Acquisition Status window or within the Queue window.
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 Stop:
Stop Current Task button terminates data acquisition at the completion of the current Frame/Sweep/Cycle and saves the data file. Analysis will proceed on other analysis positions or other queues.
[image: image30.png]


 Stop All: [button to the right of the Stop]
Stop All Tasks button terminates data acquisition at the completion of the current Frame/Sweep/Cycle and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.
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 Abort:
Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other analysis positions or other queues.
[image: image32.png]


 Abort All: [button to the right of the Abort]
Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.
6.3 Overview of XPS Output Area
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The XPS Output Area resides in the lower left section of the XPS Tab. The XPS Output Area consists of a Spectral Viewer, Profile Viewer and Image Viewer.  The Profile Viewer and Image Viewer share the right sector of this output area.  Depending on the type of data being displayed, the XPS Output Area will automatically change to display the corresponding data.    

The layout of the XPS Output Area can be selected using View in the menu bar, as seen below: 
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The tiling display orientation can be modified using the Landscape, Portrait, Square or Tall selections.  It is recommended to use the following defaults: Spectral[Portrait]; Profile[Landscape]; and Image[Square].  
The Profile Viewer and Image Viewer share the same display area. This pull-down menu allows the user to toggle between the two viewers.

· The Spectrum Viewer will display Survey and Multiplex spectra.
· The Spectrum Viewer will also display spectral information during a Depth Profiles, Angle Resolved Profiles, Line and Map acquisitions. 
· The Spectrum Viewer will also display spectral information for a saved Depth Profiles, Angle Resolved Profiles or Line acquisitions. Note: saved Map spectral data is not redisplayed.
· The Profile Viewer will display Depth and Angle Resolved Profiles and Line scans.

· The Image Viewer will display Maps and “saved” SXI images.

Each of these viewers can be set-up for either “FullScreen Data” or “Tile Data” viewing when multiple files are displayed in a single viewer.  See information in the table on the next page.  

The display with a “Green Caption” is the current “highlighted” display.  Modification, annotation, data reduction and other toolbar functions will apply to this “highlighted” display only.

The XPS Viewer toolbar buttons and their actions are listed here:

Spectral Viewer:
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Profile Viewer:
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Image Viewer:
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 Fullscreen/Tile:
Resizes the corresponding viewer’s output area; 
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 is used for a full screen view; 
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 reduces the area so the Platen Viewer and SXI Viewer and data viewers can be seen.
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 Fullscreen Data/Tile Data:
Toggles between displaying all open files (spectra, profiles, lines and maps) or displaying the currently active file.
The currently active file is indicated with a “Green Caption”. 
[image: image44.jpg]


 is used to display all open files 
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 is used to display the currently active file (see Current Curve below)
[image: image46.jpg]


 Annotation:
Click this button and then double-click over the output area to add text to the Spectrum, Profile, Lines or Maps.  A text box is created that can be moved.  Double-click twice over the box to edit text.  More options are detailed below.
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 Zoom:
Click this button and then click within the viewer (Spectrum, Profile or Image). Drag to draw a box around the area you want enlarged.
Note: right-click and select FullScale to return the viewer to the original view.
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 Energy Cursor:
Click this button and then click over the selected spectrum.  The Energy at the cursor’s location is displayed. 
In the Profile Viewer, either the profile’s sputter time at the cursor’s location is displayed or the line’s position (um) at the cursor’s location is displayed.
[image: image49.jpg]


 Element Cursor:
Click this button and then click over the selected spectrum.  The Energy at the cursor will be displayed.  Elements with XPS peaks at the cursor’s location are also displayed.
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 Current Curve:
When a file is open where a spectral data was acquired for multiple regions, areas, or cycles; use Current Curve to designate the data curve to be displayed and to designate which curve other toolbar functions will be applied to. (Use this in conjunction with the Show One button)
NOTE:Region/Area/Cycle designators make-up the pull-down names

Survey Files:
Region =Sur1;
Area= 1,2,3..[Area#];
Cycle= 1 [co-added data]

Multiplex Files:
Region =Element(s);
Area= 1,2,3..[Area#];
Cycle= 1 [co-added data]

Profile Spectral Files:
Region =Element(s);
Area= 1;
Cycle= 1,2,3.. [Sputter Depth Cycle]

Line or Map Spectral Files:
Region =Element(s);
Area= 1;
Cycle= 1,2,3.. [Spatial Position].
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 Show One:
Shows only the data curve selected in the Current Curve box.
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 Show All:
Shows all the data curves of a spectrum.
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 9 Point Savitsky-Golay Smooth:
Smoothing reduces the noise evident in spectral data, improving the visual presentation and aiding with data interpretation.  This operation can be performed on live data during analysis or on redisplayed data from a file.  A 9-point Savitzky-Golay smooth is performed on all of the spectrum’s data curves.
NOTE:  The Savitzky-Golay algorithm is a polynomial function that eliminates some noise from the data and tends to preserve the peak shapes of the original data.
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 Periodic Table:
Click this button to bring up the Periodic Table box.  The box consists of three tabs.  Peak ID is used to label peaks on existing spectra – click the element to label it on the selected spectrum.  Acquisition Setup is used to select elements for analysis.  Peak ID Filter displays the elements used by SmartSoft-XPS for automatic peak identification.  Selected elements have XPS transitions that allow for automatic identification.
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 Peak Identification:
Click this button to automatically identify peaks on a spectrum.
[image: image56.jpg]


 Close File:
Closes current file selected (indicated by “Green Caption” above the display).  
Note: all displays associated with this file will close.
[image: image57.jpg]


 File Information…:
Opens a window displaying both Parameters saved with the data file and raw Data saved.  This link is also available in the Platen Manager.
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 Copy/Print:
Click the copy button to Copy the active file to the clipboard for insertion into MS Office applications; click the Print button to print the file to the default printer.
[image: image59.png]


 Display Plot Legend:
Opens a window displaying a color based legend of the displayed regions within the currently highlighted viewer.
[image: image60.png]


 Brightness (Gamma):
Click this button and left-click inside the Image Viewer.  Holding the left-mouse-button while sliding the mouse right/left will increase/decrease the Brightness(Gamma) for the selected display.
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 Contrast Stretch:
Click this button and left-click inside the Image Viewer.  Holding the left-mouse-button while sliding the mouse right/left will increase/decrease the Contrast for the selected display.
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 Current Image:
In the Image Viewer use this to designate the image to be displayed in the Tile mode and to designate which image other toolbar functions will be applied to.
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 Color Map:
In the Image Viewer use this to toggle the currently active image between a Gray, Thermal, Red, Green or Blue display.
[image: image64.png]


 Standard Annotation:
Selecting this button in the Image Viewer will add reference annotation to the currently active display: Image Size (FOV/Magnification); Beam Voltage; Micron Marker; PHI logo; Photo Number; Comment; and Date.
[image: image65.bmp] RGB Overlay:
Use this feature to overlay multiple images. When multiple images are displayed in Red, Green or Blue; selecting this button will create a new image compiled of data from each of the files currently displayed in Red, Green or Blue.
Right-click within a viewer to bring up a context menu with additional options, as seen below.
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Additional options in the context menu include:

Copy to Clipboard:  
Copies the file to the clipboard; it can then be pasted into Microsoft Office® applications.

Delete All Annotation:
Deletes all annotation from the Viewer.

Full Scale (X and Y): 
Restores the total view after Zoom has been used.

Full Scale (Y):  
Restores the entire Y axis display after Zoom has been used.

Paste: 
Inserts text from the clipboard into the file as an annotation.

Print:  
Prints the file.

Undo Brightness:
Undo any brightness correction

Undo Contrast:
Undo any contrast correction

Properties…:
Opens a window providing access to change Properties in the viewer

Annotation Properties…:
Opens a window providing access to change Annotation Properties in the viewer
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Peak Id:
These parameters can be used to modify the Peak Id labeling annotation.
Text:
These parameters can be used to modify the user text annotation.
Plot:
These parameters can be used to modify the viewer labeling annotation.
6.4 Overview of the XPS Application tabs
6.4.1 Acquisition Properties (All XPS Applications)
Each of the XPS acquisition tabs will provide access to the Acquisition Properties window.

Setup
The Setup tab will provide pre-acquisition, acquisition and post-acquisition properties for all acquisitions.
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Stage Movement During Acquisition
Lower Tilt:
When set to Enabled; automated drives to the next position during an acquisition will result in the Tilt axis being set to a safe 45 degrees while the platen is moved to its new position.
Lower Z:
When set to Enabled; automated drives to the next position during an acquisition will result in the Z axis being set to a safe height while the platen is moved to its new position.
Note: it is recommended to leave both Lower Tilt and Lower Z “Enabled” for safe automated drive to the next positions.

Note: due to the possibility of sample damage, the following message will be displayed if either of these are set to Disabled.
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Automated Neutralization
E-Neut Auto Neutralization:
When set to Auto [A]; the E-Neut gun will automatically be used to provide charge compensation during an acquisition.
E-Neut Setting: [combo box]
Select the E-Neut Setting to be used to define operating parameters during automated neutralization.
Source Tolerance Required:
When set to Enabled: Data acquisition will be performed only if the E-Neut Setting’s Target Emission current is met when Auto Neutralization is started.
Ion Gun Auto Neutralization:
When set to Auto [A]; the ion gun will automatically be used to provide charge compensation during an acquisition.
Ion Gun Setting: [combo box]
Select the Ion Gun Setting to be used to define operating parameters during automated neutralization.
Z-Align Before Acquire
Z-Align:
When set to Enabled; the Z-Align operation will be performed for each Position List Table analysis position before a requested acquisition is performed.

Note: the optimized Z height determined by this operation will be used to update the current Position List Table analysis position’s Z parameter for future operations.

Note: if an optimum height cannot be determined: the Z will be returned to the original height and the requested acquisition will be performed at that height.  The user will be notified within the Acquisition Status window.
X-Ray Setting: [combo box]
Select the X-Ray Setting to be used to define operating parameters during automated Z-Align if the current Position List Table analysis position is a “Point, Line or Area analysis area”.
X-Ray Setting (High Power): [combo box]
Select the X-Ray Setting (High Power) to be used to define operating parameters during automated Z-Align if the current Position List Table analysis position is a “High Power analysis area”.
Presputter Before Acquire:
Pre-Sputter:
When set to Enabled; a pre-sputter operation will be performed for each Position List Table analysis position before a requested acquisition is performed.

Note: due to the possibility of sample damage, the following message will be displayed if this is set to Enabled.
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Presputter Setting: [combo box]
Select the Ion Gun Setting to be used to define operating parameters during automated Pre-Sputter.
Presputter Time (min):
Time used during automated Pre-Sputter.
Note: a calculated sputter depth will be displayed to the right of this field.  This will be calculated as a function of the Sputter Rate (A/min) parameter that is defined with the selected Ion Gun Setting.
Beam Parking:
Auto Beam Parking:
When set to Enabled; a post-acquisition operation will be performed to set the X-Ray gun in a “blanked” state.  This will keep the X-Ray source Emission energized and provide more stable operation of the X-Ray gun during the next operation.

Note: The X-Ray gun can be “pre-set” to the Beam Park mode in the Hardware/X-Ray application or by right-clicking on the X-Ray Status Bar and selecting Beam Park mode.
Note: See the Hardware/X-Ray section for further discussion on Beam Parking.
X-Ray Setting: [combo box]
Select the X-Ray Setting to be used to define operating parameters during automated Beam Park.
Auto Shutdown:
When set to Enabled; the post-acquisition automated Beam Park mode will be automatically set to OFF if the Auto Shutdown Delay (hrs) time has transpired since the last acquisition.
Auto Shutdown Delay (hrs):
Time used to determine when the Auto Shutdown of the Beam Park mode should be invoked.
 Region

The Region tab will provide additional acquisition parameters and Region related defaults.
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Delay (sec):
Defines the delay time between turning the X-Ray gun (and Auto Neutralization) ON and starting data acquisition.

Peak Intensity: [combo box]
Defines the method used to determine the Profile, Line or Map intensity for a given region/area. Choices are None; Area; Height; Total Signal; LLS Average; Centroid.
Peak to Noise:
Disabled will allow the acquisition control to perform all Sweeps/Cycles for all Regions requested.
Enabled will check the Peak-Noise value for each Region after each Sweep.  If the signal level meets the Peak-Noise criteria; the remaining Sweeps and Cycles for that Region will be skipped.
Note: Profile Cycles are new acquisitions and the Peak-Noise requirement will need to be met again for each Profile Cycle.
Default Peak to Noise:
Defines the threshold that needs to be met when the Peak to Noise is Enabled.

Default Region Values
The table shows the default eV/Step and Ratio associated with a chosen Pass Energy that will be assigned in the Regions parameters when a Region is added or when a Regions’ Pass Energy is modified.


eV/Step(Scanned): [combo boxes]
These values in this table represent the default eV/Step that will be assigned for a Scanned region.
Note: each combo box will contain the 2 or 3 choices that are available for a given Pass Energy.
eV/Step(UnScanned): [read only]
These values in this table represent the default eV/Step that will be assigned for an UnScanned region.
Note: these values are not editable and are noted here for information only.
Ratio
These values in this table represent the default Ratio that will be assigned for a Scanned region.
Note: these values are optimized to balance the count rates as a function of transmission; with transmission changing for a given Pass Energy.
 Profile

The Profile tab will provide additional parameters used during a Depth or Angle Profile.
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Zalar Accuracy:
Standard: will perform an oscillating Zalar operation between 0 and 360 degrees during the defined sputter cycle of an Alternate Depth Profile w/Zalar.  Overtime during a Depth Profile with many sputter cycles, there is a greater chance that the alignment to the analysis area may move slightly from Zalar operation to Zalar operation.
High: will perform an oscillating Zalar operation between 0 and 360 degrees during the defined sputter cycle of an Alternate Depth Profile w/Zalar.  When the Zalar Interval (cycle) is reached or when the last Profile Cycle is reached; the X, Y & R motors will be re-initialize to correct any accumulated error that has been created.
Zalar Interval (cycle):
Defines which Profile Cycle that the re-initialization of the X, Y & R motors will occur in [when the Zalar Accuracy is set to High].
Rotation Speed (min):
Defines the time interval to complete a Zalar Rotation from 0 to 360 degrees.
PreSputter Cycles:
Defines the number of Profile acquisition cycles collected before beginning the Sputter Cycles. 
Note: this value will be added to the Sputter Table sputter cycles to determine the Total Profile Cycles.
Delay After Sputter (sec):
Defines the settling time allowed for Auto Neutralization to minimize the sample charge created during the sputter cycle.
X-Ray Off During Sputter:
Yes: sets the X-Ray gun to OFF [or Beam Park if the Auto Beam Park is Enable] during the sputter cycle between acquisitions. 
No: leaves the X-Ray gun operation ON during the sputter cycle between acquisitions.
Acceptance Angle:
Standard: uses standard Gauze Lens and Analyzer parameters during data collection. 
Narrow: alters the Lens2, Lens3, Lens4, Lens5 and Rotator values [per the Scalens.txt file] to narrow the input acceptance angle of the analyzer to optimize performance [typically used during an Angle Resolved Profile].
 Z-Align

The Z-Align tab will provide parameters used during Z-Align operations (SXI or XPS Acquisition).
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Acquire Time (s):
Defines the data collection time at each Z position.
Coarse Step (mm):
Coarse Step is the step size of the Z axis in the preliminary operation of searching for an increase in signal.
Note: Once an increase is detected; the Z will be dropped 05.mm and step using the Fine Step.
Fine Step (mm):
Fine Step is the step size of the Z axis in the final operation of searching for a peak in the signal vs. Z height.
Background Uncertainty Factor:
This value is used to weight the average background signal.  This weighted value is subtracted from the collected signal at each Z step.
Peak Uncertainty Factor:
Currently not used.

Background Points To Average:
Defines the number of events that are averaged in determining the background.
Valid Peak Ratio:
Defines the Peak to Background Ratio that needs to be detected to validate the Z-Align operation.
Note: if a Peak is not determined; the Z will be moved back to the original height.
Continuous Neutralization:
Checking this box will over-ride the “pulsed” Ion Neutralization before Z-Align and allow the Ion Neutralization to be ON continuously during the Z-Align operation [all of this still dependant on whether the Ion Auto Neutralization is Enabled].
6.4.2 Settings Overview (All XPS Applications)
The operation of the Settings, Acquire and Acquisition Setup functions are similar for all acquisition operations and will be discussed here once.
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Spectrum Settings: [combo box]
A list of previously defined Settings containing all X-Ray Settings, Acquisition Parameters and Region lists information for a XPS acquisition.
Load; Save; Delete:
Delete the current setting in the Settings combo box; 
Load the parameters previously saved for the selected Setting in the combo box;
Save the current parameters [X-Ray Settings, Acquisition Parameters and Region lists] using the “previous name” or “newly entered name” in the Settings combo box.
File:
Allows the user to Load previous parameters used during a prior acquisition.  The following window will open allowing the user to browse for a file and load these parameters.
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6.4.3 Acquire & Queue Overview (All XPS Applications)
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Start:
Start an Acquisition using:

· Active positions in the Sample Position List Table
· Pre- acquisition and other parameters defined in the Acquisition Properties
· Acquisition parameters defined on the current XPS tab

More:
Selecting More will allow the user to extend the last acquisition using:

· The current position in the Sample Position List Table
· Neutralization parameters defined in the Acquisition Properties

· Current or new parameters defined by the user and unique for each analytical technique on the current XPS tab
Then select Start to extend the last acquisition using the current or new parameters:
Note: see the discussion for each XPS Applications as each have unique requirements and available parameters that can be modified.
Note: More is not available for all XPS Applications
Add Q: [Add To Queue]
Right-click this button to Clear (the) Queue
Click this button to Add an acquisition to the Queue using:

· Active positions in the Sample Position List Table
· Pre-acquisition and other parameters defined in the Acquisition Properties
· Acquisition parameters defined on the current XPS tab

Open Q:
Click this button to open/view the Queue window:
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Setting: [combo box]
Select a previous Queue setting and use the Load, Save or Delete function.
Load; Save; Delete:
Delete the current setting in the Settings combo box; 
Load the parameters previously saved for the selected Setting in the combo box;
Save the current parameters [Platen Parameters, Acquisition Parameters and Region lists] using the “previous name” or “newly entered name” in the Settings combo box.
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 Toolbar
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 Run:
Clicking the Run icon will start processing the Queue Jobs at the beginning of the list.
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 Pause:
Select a previous Queue setting and use the Load, Save or Delete function.
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 Stop:
Stop Current Task button terminates data acquisition at the completion of the current Frame/Sweep/Cycle and saves the data file. Analysis will proceed on other analysis positions or other queues.
[image: image88.png]


 Stop All: [button to the right of the Stop]
Stop All Tasks button terminates data acquisition at the completion of the current Frame/Sweep/Cycle and saves the data file. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.
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 Abort:
Abort Current Task button terminates the acquisition immediately and eliminates the data file that was created. Analysis will proceed on other analysis positions or other queues.
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 Abort All: [button to the right of the Abort]
Abort All Tasks button terminates the acquisition immediately and eliminates the data file that was created. The Queue will advance to the end of the current Queue Job and stop the acquisitions process.
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 Delete:
Removes the currently highlighted Queue Job from the list.
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 Clear
Removes all Queue Jobs from the list.
Job
These column values indicate the XPS analysis to be performed for each Job.
Summary
These column values indicate the following acquisition parameters:  Platen Name || analysis positions from the Position List Table || analysis X-Ray setting || (optional Z-Align X-Ray Setting) || Regions.  These parameters will be used while executing each Job.
Additional functionality:

· Right-click on a Job and select Run From Here if desired.

· The Status tab will reveal acquisition history and any error reporting.

· A yellow border will appear on the Queue window if an error has been reported on the Status tab

· The Diagnostics window is available by right-clicking within the Queue window
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This will reveal an AutoTool window with a Task List showing a complete breakdown of all tasks required to perform all Queue Jobs.  Each Job will be separated by a set of dashes.  All Pre-Acquisition, Acquisition and Post-Acquisition tasks will be shown.
6.4.4 Region List Overview (All XPS Applications)
The operation of this area is similar for all acquisition operations and will be discussed jointly.
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Scanned
UnScanned
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 Show Table Details:
Selecting this icon will open a new window revealing additional Region parameters that have automatically been defined for each region.  
Profile is referenced here as both Scanned and UnScanned Region Tables are available for Profiles.

Scanned
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UnScanned
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Active: [check box]
Checking these boxes will select which Regions will be analyzed.
Name:
This field will list each Transition Element defined in the Region Table.  Typing in this field will edit the Transition Element, and if the element is found in the Transition Data Base; then the Region acquisition information for that Element will be updated.
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Right-clicking on this field will reveal a Transition Element look-up table.
Sweeps:

This field defines the number of times the data will be collected for each Region before proceeding to the next Region.

Lower; Range; Upper; Analysis Lower; Analysis Upper:

Within the “Scanned” Region List; the Lower, Range and Upper parameters define the acquisition parameters for data collection for each Region.  The Analysis Lower and Analysis Upper parameters define the analysis window that will be used in calculating the Profile or Angle intensity data for each Region.

Peak; Range; Analysis Peak; Analysis Range:

Within the “UnScanned” Region List; the Peak and Range parameters define the acquisition parameters for data collection for each Region.  The Analysis Peak and Analysis Range parameters define the analysis window that will be used in calculating the Profile, Angle, Line Map intensity data for each Region.

Pass Energy [Pass]: 
The Pass Energy will define the analyzer band pass and resultant alignment of energies across the 32 channels.

eV Step:
The eV Step will define the energy resolution of the data file for each Region.  

Ratio:

The Ratio will define the weighted collection time for each Region and effectively is multiplied by the TimePerStep in determining the data collection time at each energy step for a given Region.

Peak To Noise: [P/N]
Peak to Noise defines a Peak to Background ratio that needs to be met for each Region if the Peak To Noise acquisition parameter is Enabled in the XPS > Properties > Region window.
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 Add; Insert; Delete; Erase All:
These tools allow the user to manually edit the Region List.  The Periodic Table and Import Elements tools provide more powerful Region List editing capabilities.
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 Periodic Table:
This tool allows the user to add Regions to the Region List using to Periodic Table to select Regions.

· Newly selected Regions will be added to the end of the list
· Holding the “Shift” key will allow entry of the same Region multiple times
· Su is a custom Region with a range of 0-1100eV
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 Import Elements:
This tool allows the user to import the list of Regions defined in one of the other acquisition applications or to import Regions identified in the currently highlighted Spectral Viewer [Import Spectral Display button].
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 Refresh:
Refresh is available to provide a real-time display of data for a single Region that will not be saved.  Selecting the Refresh icon will raster a point analysis area using the Beam Offset X & Y from the Refresh window; setup the analyzer tuned to the highlighted Region parameters; load the Acquisition Setup X-Ray Setting; turn on the X-Ray gun; collect one sweep of data and update the Refresh viewer.  This acquisition will run until Stopped or Aborted.
· The highlighted Region in the Region Table will be acquired in either a “Scanned” or “UnScanned” collection mode depending on the Analyzer Mode selected in the current application tab
· The Sweeps and Ratio will default to a temporary value=1

· The “Scanned” Time Per Step (ms) will default to a temporary value=10ms
The “UnScanned” Time Per Region (ms) will default to a temporary value=1000ms

· The Persistence can be used to integrate more counts to improve the signal-noise

· Selecting a new Region in the Region List (or editing Region parameters for the current Region) will automatically restart the Refresh acquisition using the new parameters
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 Refresh Acquire:
Click to start a new Refresh acquisition.
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 Stop Refresh Acquisition:
Click to Stop the Refresh acquisition without closing the Refresh window.
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 Copy; Print:
Copy the viewer for importing into MS applications or Print viewer to the default printer.
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 Large Counts Display:
Toggle this icon to reveal the Large Counts Display at the top of the viewer.

Persistence:
Change this value to integrate data longer than one refresh if the signal intensity is too low.
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 Beam Offset X & Y:
These fields define the position (um) of the X-Ray beam with respect to the center of the analysis area during a Refresh acquisition.
Max Counts; Energy: [display only]
This field displays the maximum intensity in the acquisition window and reveals the counts and energy associated with this maximum intensity.

Cursor Counts; Energy; (Cursor): [display only]
This field displays the intensity in the acquisition window at the energy aligned with the cursor and reveals the counts and energy associated with this intensity.  Move the green cursor along the data to pick other intensity information.
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 Close:
Use this button to close the Refresh window when finished.
Note: Selecting the Close button will also Stop the Refresh acquisition.
Note: Stopping the Refresh acquisition will leave the window open for further use.

6.4.5 Spectrum Tab
High level acquisition parameters are defined here for Spectral and Multiplex acquisitions.
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Analyzer Mode: [read only]
Scanned Only.

Pass Energy:
This value will be used to set the Pass Energy for all Regions in the Region Table or to set the default Pass Energy for new Regions added to the Region Table.

Time Per Step (ms):
This value will be used with each region’s Ratio value to determine how much time is spent at each energy step in the Scanned acquisition.

Cycles:
The user selects the number of cycles that will be performed of the Region Table.  This selection will [in conjunction with Range(eV); eV/step; Time/Step & #Regions ] define the Analysis Time (min) for the acquisition.
Analysis Time (min): [read only]
This value represents the Data Analysis Time for each analysis position in the Position List Table.  Calculated as a function of [Range(eV); eV/step; Time/Step] [ #Regions ] [#Cycles].
Runtime: [read only]
This value represents the Runtime time for each analysis position in the Position List Table.  This calculation includes any overhead required to perform data acquisition related tasks.
6.4.6 Depth Profile Tab
High level acquisition parameters are defined here for Depth Profile acquisitions.
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Profile Parameters:

Analyzer Mode:
Scanned or UnScanned
Pass Energy:
This value will be used to set the Pass Energy for all Regions in the Region Table or to set the default Pass Energy for new Regions added to the Region Table.

Time Per Step (ms):
In a “Scanned” mode this value will be used with each region’s Ratio value to determine how much time is spent at each energy step in the Scanned acquisition.

Time Per Region (ms):
In an “UnScanned” mode this value will be used to determine how much time is spent at each Region in the UnScanned acquisition.

Analysis Time (min): [read only]
This value represents the Data Analysis Time for each analysis position in the Position List Table.  Calculated as a function of [Range(eV); eV/step; Time/Step] [ #Regions ] [#Cycles].
Runtime: [read only]
This value represents the Runtime time for each analysis position in the Position List Table.  This calculation includes any overhead required to perform data acquisition related tasks.
Sputter Mode:

Alternating: 

After any pre-sputter acquisition cycles [defined in the Acquisition Properties] the analysis area will be alternately sputtered [per the Sputter Table parameters] and analyzed [per the Profile Parameters and Region parameters]
Note: Auto Neutralization with the Ion Gun will be invoked during analysis if Enabled
Alternating w/Zalar: 

After any pre-sputter acquisition cycles [defined in the Acquisition Properties] the analysis area will be alternately sputtered [per the Sputter Table parameters] and analyzed [per the Profile Parameters and Region parameters]
Zalar Rotation will be used to optimize the uniformity of the sputtering process.
Note: Auto Neutralization with the Ion Gun will be invoked during analysis if Enabled
Continuous: 

After any pre-sputter acquisition cycles [defined in the Acquisition Properties] the analysis area will be analyzed [per the Profile Parameters and Region parameters] and continuously sputtered [per the Sputter Rate Sputter Setting parameters]
Note: Auto Neutralization with the Ion Gun will-NOT be invoked during analysis
No Sputter: 

After any pre-sputter acquisition cycles [defined in the Acquisition Properties] the analysis area will be analyzed [per the Profile Parameters and Region parameters] and not sputtered
Note: Auto Neutralization with the Ion Gun will be invoked during analysis if Enabled
Sputter Rate:

Sputter Time (min): [read only]
Calculated as a function of Sputter Table parameters.
Cycles: [read only]
Calculated as a function of Sputter Table parameters and pre-acquisition cycles.
Sputter Rate Table (n) …:
Selecting this button will open the following window
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 Add; Insert; Delete; Erase All:
Use to define/setup the number of sputter layers

Layer Name:
Defaults to Layer1, Layer2 or can be custom-named
Time (min):
Define total Time(min) spent at each layer with this time broken up into Intervals(min) of sputter/analysis Cycles
Depth (A): [read only]
Calculated depth per Layer as a function of Time (min) times Rate (A/min) [a parameter of the selected Sputter Setting]

Interval:
Interval(min) is the sputter time spent at each interval of a sputter/analysis Cycle.  The Time (min) should be a multiple of the Interval entered to produce an integer number of sputter/analysis Cycles for a given Layer
Cycles: [read only]
Calculated per Layer as a function of Time (min) divided by Interval
Sputter Setting:
User defined Ion Gun Setting to be loaded during each sputter Layer
Rate (A/min): [read only]
A parameter of the selected Sputter Setting.
Continuous and No Sputter Sputter Modes:
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Sputter Setting:
User defined Ion Gun Setting to be loaded during Continuous sputter.

Cycles:
User defined number of cycles to be collected in addition to the pre-sputter cycles

Total: [read only]
Calculated number of cycles to be collected including the pre-sputter cycles

Sputter Rate (A/min): [read only]
A parameter of the selected Sputter Setting.

Sputter Depth (A): [read only]
A Continuous Profile parameter calculated as a function of Cycles times Sputter Rate (A/min).

6.4.7 Angle Profile Tab
High level acquisition parameters are defined here for Angle Profile acquisitions.
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Analyzer Mode:
Scanned or UnScanned
Pass Energy:
This value will be used to set the Pass Energy for all Regions in the Region Table or to set the default Pass Energy for new Regions added to the Region Table.

Time Per Step (ms):
In a “Scanned” mode this value will be used with each region’s Ratio value to determine how much time is spent at each energy step in the Scanned acquisition.

Time Per Region (ms):
In an “UnScanned” mode this value will be used to determine how much time is spent at each Region in the UnScanned acquisition.

Analysis Time (min): [read only]
This value represents the Data Analysis Time for each analysis position in the Position List Table.  Calculated as a function of [Range(eV); eV/step; Time/Step] [ #Regions ] [#Cycles][#Angles].
Runtime: [read only]
This value represents the Runtime time for each analysis position in the Position List Table.  This calculation includes any overhead required to perform data acquisition related tasks.
Cycles: [read only]
Calculated number of Cycles to be collected [the sum of the Cycles listed in the Angle Table]
Angle Table (n) …:
Selecting this button will open the following window
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 Add; Insert; Delete; Erase All:
Use to define/setup the number of Angles to analyze
Angle:
Defines the Analyzer Take Off Angle for each acquisition step during the Angle Resolved acquisition
Cycles:
The user selects the number of cycles of the Region List that will be performed for each Angle in the table.  
Note: Lower Angles require more Cycles as sensitivity is reduced. 

6.4.8 Line Tab
High level acquisition parameters are defined here for Line acquisitions.
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Analyzer Mode: [read only]
UnScanned only

Pass Energy:
This value will be used to set the Pass Energy for all Regions in the Region Table or to set the default Pass Energy for new Regions added to the Region Table.

Cycles:
The user selects the number of cycles of the Region List that will be performed. This selection will [in conjunction with Range(eV); eV/step; Time/Step & #Regions ] define the Analysis Time (min) for the acquisition.
Note: With Line acquisitions the Time Per Energy is defaulted to “multiples of 5 seconds” and the time spent at each Region = Sweeps * 5 seconds 
The Sweeps field in the Region tables can be used to define the ratio of time spent between Regions
Analysis Time (min): [read only]
This value represents the Data Analysis Time for each analysis position in the Position List Table.  Calculated as a function of [Range(eV); eV/step; Time/Step] [ #Regions ] [#Cycles].
Runtime: [read only]
This value represents the Runtime time for each analysis position in the Position List Table.  This calculation includes any overhead required to perform data acquisition related tasks.
6.4.9 Map Tab
High level acquisition parameters are defined here for Map acquisitions.
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Analyzer Mode: [read only]
UnScanned only

Pass Energy:
This value will be used to set the Pass Energy for all Regions in the Region Table or to set the default Pass Energy for new Regions added to the Region Table.

Sweeps Multiplier:
Each Region will be analyzed sequentially.  The Time Per Region will be multiples of 7 seconds [7 * #Sweeps * Sweeps Multiplier].  The Sweeps fields in the Region tables can be used to define the ratio of time spent between Regions.  The Sweeps Multiplier can be used to define to total Analysis Time
Analysis Time (min): [per Area] [read only]
This reflects the Analysis Time for each analysis area defined at each analysis position in the Position List Table. Calculated as a function of [7(sec) * Total # Sweeps in Region table * Sweeps Multiplier]

Runtime: [per Area] [read only]
This reflects the Runtime for each analysis area defined at each analysis position in the Position List Table.  This time includes any overhead to perform data acquisition related tasks.
6.4.10 Application Log: Acquisition

Right-click within any XPS > Application tab and select Application Log:()…
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Application Log windows are described in the Introduction and Overview section [image: image128.jpg]
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